User guide
ARTEC STUDIO 10
## Contents

### 3D Scanning at a glance

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Getting started</td>
<td>11</td>
</tr>
<tr>
<td>1.1 Welcome</td>
<td>11</td>
</tr>
<tr>
<td>1.2 Introduction</td>
<td>12</td>
</tr>
<tr>
<td>1.3 System requirements</td>
<td>13</td>
</tr>
<tr>
<td>1.4 Conventions and acronyms</td>
<td>14</td>
</tr>
<tr>
<td>1.5 Glossary</td>
<td>14</td>
</tr>
<tr>
<td>1.6 User’s account</td>
<td>15</td>
</tr>
<tr>
<td>1.7 Scanner activation</td>
<td>16</td>
</tr>
<tr>
<td>1.7.1 Artec Installation Center installation</td>
<td>16</td>
</tr>
<tr>
<td>1.7.2 3D Scanner activation with Artec Installation Center installed</td>
<td>16</td>
</tr>
<tr>
<td>1.8 Artec Studio Installation</td>
<td>17</td>
</tr>
<tr>
<td>1.9 Offline activation</td>
<td>18</td>
</tr>
<tr>
<td>1.10 Deactivation</td>
<td>21</td>
</tr>
<tr>
<td>1.11 Managing Artec 3D Scanners and Products</td>
<td>22</td>
</tr>
<tr>
<td>1.12 Getting started with Artec Studio</td>
<td>23</td>
</tr>
<tr>
<td>1.12.1 Main window</td>
<td>23</td>
</tr>
<tr>
<td>1.12.2 Primary settings</td>
<td>25</td>
</tr>
<tr>
<td>2 Scanning</td>
<td>26</td>
</tr>
<tr>
<td>2.1 Preparation</td>
<td>26</td>
</tr>
<tr>
<td>2.1.1 Connecting the 3D Scanner</td>
<td>26</td>
</tr>
<tr>
<td>2.1.2 Algorithm settings</td>
<td>26</td>
</tr>
<tr>
<td>2.1.3 3D Scanner setup</td>
<td>27</td>
</tr>
<tr>
<td>2.2 Using 3D Scanner</td>
<td>29</td>
</tr>
<tr>
<td>2.2.1 Scanning algorithms and trackers</td>
<td>29</td>
</tr>
<tr>
<td>2.2.2 Common scanning principles and basics</td>
<td>29</td>
</tr>
<tr>
<td>Losing and resuming tracking</td>
<td>31</td>
</tr>
<tr>
<td>Misalignment detection</td>
<td>32</td>
</tr>
<tr>
<td>Continue scanning from scans selected in Workspace</td>
<td>32</td>
</tr>
<tr>
<td>2.2.3 Notes on scanning with Spider scanner</td>
<td>32</td>
</tr>
<tr>
<td>2.2.4 Notes on scanning with Third-party 3D sensors</td>
<td>33</td>
</tr>
<tr>
<td>2.2.5 Long-distance scanning with Kinect v2</td>
<td>33</td>
</tr>
<tr>
<td>2.2.6 Notes on scanning with MHT scanner</td>
<td>34</td>
</tr>
<tr>
<td>2.2.7 Scanning with Geometry + Texture tracker</td>
<td>34</td>
</tr>
<tr>
<td>Turning scanner flash off</td>
<td>36</td>
</tr>
<tr>
<td>2.2.8 Scanning with Geometry tracker</td>
<td>37</td>
</tr>
<tr>
<td>2.2.9 Scanning with Real-time Fusion</td>
<td>38</td>
</tr>
</tbody>
</table>
5.2 Scan alignment .................................................. 75
   How to select scans and run alignment ..................... 75
   How to change scan status .................................. 75
   Displaying scans in 3D View ................................ 76
  5.2.1 Drag alignment ............................................. 76
  5.2.2 Automatic rigid alignment ............................... 77
  5.2.3 Manual rigid alignment without points specifying .... 77
   Texture alignment ............................................... 78
  5.2.4 Understanding specifying points and editing their position 78
  5.2.5 Manual rigid alignment with points specifying .......... 79
  5.2.6 Non-rigid alignment ....................................... 79
  5.2.7 Constrained alignment .................................... 81
5.3 Global registration .............................................. 82
  5.3.1 Global registration parameters ......................... 82
  5.3.2 Possible global registration errors .................... 82
5.4 Outlier removal ................................................. 83
5.5 Fusion .......................................................... 84
  5.5.1 Possible fusion algorithm errors ....................... 86
5.6 Model editing .................................................... 87
  5.6.1 Correcting triangulation errors ......................... 87
  5.6.2 Filter for small objects ................................ 88
  5.6.3 Hole filling and edge smoothing ........................ 89
  5.6.4 Automatic hole filling ................................... 89
  5.6.5 Smoothing .................................................. 90
  5.6.6 Mesh simplification ....................................... 91
   Conventional algorithm ....................................... 91
   Fast mesh simplification .................................... 92
5.7 Automatic Processing ........................................... 93
5.8 Texturing ....................................................... 94
  5.8.1 Texture mapping .......................................... 94
  5.8.2 Texture adjusting ........................................ 96
5.9 Manual inpainting with Texture healing brush ............. 98

6 Additional modes .................................................. 100
  6.1 Publishing to Web ............................................ 100
   Model requirements .......................................... 102
   Fixing issues .................................................. 102
  6.2 Multicapturing ................................................ 102
    6.2.1 Bundle creation ....................................... 104
    6.2.2 Multicapturing ....................................... 105
  6.3 Measuring Tools ................................................ 107
    6.3.1 Linear distance ........................................ 107
    6.3.2 Geodesic distance ...................................... 108
    6.3.3 Sections as means of measuring area and volume .... 109
    6.3.4 Surface distances maps ................................. 112
    6.3.5 Annotations ............................................. 114

3
F Assembling the calibration rig  \hspace{2cm} 144
G Third-party 3D sensors  \hspace{2cm} 145
Index of parameters  \hspace{2cm} 145
3D Scanning at a glance

Before you start with this user guide and proceed to the introductory chapter, we want to show you that 3D scanning is not so difficult as it may seem to be. Although the manual covers all the matters related to Artec scanners and software and is well-structured, you may need the whole picture at your fingertips. This brief summary is intended to help you get started at once! By the way, if you are not big on this approach and prefer comprehensive and detailed information, feel free to skip this chapter.
Prepare the object and decide on scanning way

- Scan one side
  - Rotate
  - Scan another side

- Scan the whole object

- Cut surroundings
- Align
- Global registration
- Eliminate noise
- Fuse
- Erase flaws
- Simplify mesh
- Map texture
- Measure
- Export
- Share
Activate

Scanner case includes everything you may need to get started with 3D scanning, except for personal computer. Generally speaking, PC for scanning should be modern and operate under Windows 7 or 8, both x64. The more powerful PC the better. More attention should be paid to main memory (RAM) and graphics card (avoid laptops with an integrated graphics chipset).

If you have got one, do not be hasty to connect the scanner to it! Keep on reading...

[For more technical info, see 1.3.]

- Sign up on my.artec3d.com.
- Sign in and download Artec Installation Center just on the welcome page.
- Install AIC. Enter your e-mail and password when asked.
- Plug the scanner into a power outlet, then connect it to PC via USB cable.
- Wait while Windows detects the scanner. Click Activate.
- Click Install in the Software section to get Artec Studio ready for work.

[For more detailed info, see 1.6, 1.7 and 1.9.]

Prepare

Most of the objects can be easily scanned. Before scanning transparent, reflective or black objects, it is advisable to coat them with a powder or a special anti-glare spray (a dusted gear is shown in the picture). Scan monochrome objects of simple geometric shapes by:

- adding auxiliary objects (e.g. scrunched paper) on the scene;
- painting markers (e.g. X-shaped) on the surroundings.

Provide good ambient light. [For more info, see 2.2.11.]

Scan

1. Launch Artec Studio, point the scanner at the object.
2. Press F7 on the keyboard or > on the scanner body for immediate start of Preview mode.
   - Geometry+Texture is default and suitable for most of the cases.
   - Geometry mode runs well on a slower PC.
   - Real-time fusion mode creates model in real-time, allowing to skip post-processing. To run it, click Stop, then select the checkbox of the same name and click Preview.
3. Make sure the object is visible and press > once again to initiate recording. Scan the object from all sides at a time if possible, slowly moving the scanner around it, as pictured.

4. While scanning, pay more attention to the object on the screen rather than to the real one.
5. If a buzzer is heard and the error against a red background occurs, smoothly point the scanner to the already scanned area. There are some possible reasons for the “Tracking is lost” error:
   (a) scanning simple geometric shapes;
   (b) scanning too small part of the object;
   (c) too fast movement.
6. Press , the scan will be created in the right panel.
Rotate

Turn the object and scan unscanned regions (press \(\mathcal{R}\)), if any. Also record at least one scanned region, thus facilitating further alignment.

[For more info, see A, 2.1.2, 2.1.3, 2.1.13, 2.2.1, 2.2.7, 2.2.8 and 2.2.9.]

Cut surroundings

As soon as you finish, click File and select Save Project. Close Scan panel and preliminary registration will automatically start. Then you can cut off surroundings.

What for? To erase auxiliary surfaces (table or floor).

Steps: Open Editor \(\rightarrow\) Eraser \(\rightarrow\) Cutoff plane selection \(\rightarrow\) Follow the instructions.

[For more info, see 5.1.3.]

Align

What for? To align several scans. Skip this step if there is only one scan in the right panel.

Steps:
1. Mark two or more scans with \(\bigcirc\), click Align \(\rightarrow\) and select all those scans in the Rigid tab while holding the Ctrl key.
2. Click Auto-alignment.
3. If alignment has failed due to lack of texture or overlapping areas, manually match features between scans and click Align meshes.

[For more info, see 5.2.]

Global registration

What for? To optimize frames position within all scans at once, thus preparing them for further processing.

Steps: Mark scans with \(\bigcirc\) \(\rightarrow\) click Tools \(\rightarrow\) Global registration \(\rightarrow\) Apply.

[For more info, see 5.3.]

Eliminate noise

What for? To erase large outliers and some noise.

Steps: Open Tools \(\rightarrow\) Outlier removal \(\rightarrow\) Apply.

[For more info, see 5.1.3 and 5.4.]

Fuse

What for? To get a model (a single surface as opposed to multiple surfaces which the source scan is built from).

Steps: Open Tools \(\rightarrow\) Smooth Fusion \(\rightarrow\) Select Watertight \(\rightarrow\) Apply.

To obtain sharper surfaces, select Sharp Fusion. In both cases, resolution can be adjusted: the smaller resolution value the more precise resulting surface.

[For more info, see 5.5.]
Erase flaws (optional)

What for? To erase outliers and badly scanned regions, if present.

Steps: Click Editor → Defeature brush → Follow the instructions. [For more info, see 5.1.3]

Simplify mesh

What for? To get a smaller file with a reduced number of polygons and without significantly distorting the actual 3D geometry.

Steps: Click Tools → Select Mesh simplification → Apply. [For more info, see 5.6.6]

Map texture

What for? To get a textured model.

Steps: 1. Click Texture.

2. Select fusion and its “parent” scan(s) in the corresponding fields.

[For more info, see 5.8]

Measure/Export/Share

- Export the model: File → Export mesh → Select the required format → Specify folder and file name → OK.
- Measure the model: Open Measures → Select:
  - Linear for distance calculation (points are connected by lines)
  - Geodesic for distance calculation (points are connected by curves passing over the model surface).
  - Sections for square and volume calculation.
- Share the model on viewshape.com by opening the Publish toolbar.

[For more info, see 4.4, 6.1 and 6.3.]

Tips and Tricks

- Reset all settings to defaults (F10 → Scan tab → Reset …)
- Return changed parameters in the Tools panel to the default value: click small □ button nearby. The □ button stands for a default value.
- Save screenshot Ctrl+Shift+S.
- Annotate (Measures → Annotations → tag label → type text → Apply).
Chapter 1

Getting started

1.1 Welcome

Congratulations on the purchase of the Artec Studio. With its help irrespectively of its edition, you would be able to scan many different objects with Artec 3D Scanners. Scanning with third-party 3D sensors, such as Microsoft Kinect, Asus Xtion and others, is only available in Artec Studio Ultimate edition. This manual will provide you with information on how to use this application as well as your 3D scanner to quickly and easily create great-looking 3D models.

This manual contains several chapters:

- **Chapter 1** describes how to install the software and get started.
- **Chapter 2** explains the basic principles of object scanning and offers advice on how to organize the scanning process and obtain best results.
- **Chapter 3** describes the ways to control the object’s displaying in the 3D View window for gaining the best view of the scanned 3D models.
- **Chapter 4** contains information on data management, working with projects, data export and import, undoing recent operations, and saving history of project changes.
- **Chapter 5** focuses on data processing techniques: working with separate scans, alignment, fusion, filters, methods of defect elimination and texturing.
- **Chapter 6** demonstrates how to publish model on the Web, use additional features such as capturing using several scanners and usage of measuring tools.
- **Chapter 7** describes application settings.
- Several appendices (A, C, D) shed light on hardware peculiarities of Artec Scanners and give summary of some sections of this guide.

In case of unanswered questions, feel free to contact us at: support@artec-group.com.

And thanks for buying our products!
1.2 Introduction

The Artec Studio application may be used with one or several models of Artec 3D Scanners. It offers a quick way to create 3D models of physical objects. Besides managing capturing process, it lets you perform full post-processing of data, optimize mesh tessellation, and perform other operations to obtain a quality 3D model. The resulting complete 3D model can be sent to a CNC machine or imported into other 3D modeling applications.

All Artec 3D scanner models have been specially designed for hand-held use and stand out for their light weight and compact size. They do not require any special markers to be placed on the object being scanned.

The Artec 3D scanner is able to capture both immobile objects and scenes, as well as perform 3D scanning of mobile objects in real time. In this case the device operates as an ordinary video camera, except that instead of 2D images, it captures 3D frames at the rate of up to 15 frames per second.

Figure 1.1: Artec 3D scanners: EVA and Spider

Operating Artec 3D Scanner and its application Artec Studio is easy, no special knowledge or skills are required. To obtain a complete 3D model, scan the object from different angles and fuse the resulting scans into a single model using the Artec Studio application.

To scan different sized objects use different models of scanners: L (large), M (medium), S (small) and special Spider. Their primary difference is the depth and field of view. It is recommended to choose the appropriate scanner model when performing scanning operations.

The following recommendations generally apply to using scanners of different sizes:

- **L** – full body, monuments, architectural elements.
- **M** – full body or body parts, face, car interior, big statues.
- **S** – pencil, key, fine details on large objects, such as architectural ornaments, etc.
- **Spider** – the same objects as S, but with higher resolution and higher accuracy.

EVA and MHT scanners are as capable as M (MH) scanners, but due to ability to scan and track texture, they are more versatile and allow users scan objects, that are impossible to scan with any other scanner types like flat objects, objects with repetitive geometry and so on. It is possible to combine several different scanner types while scanning one scene. In some cases when scanning complex shapes, this will increase the scanning rate and produce results of desired precision.

Artec Studio Ultimate edition can also be used with the following third-party 3D sensors:

- Microsoft Kinect for Windows (v1 and v2);
• ASUS Xtion;
• PrimeSense Carmine;
• Devices featuring Intel RealSense 3D camera.

When using the above mentioned devices, the scan quality is not as good as with Artec 3D scanners.

1.3 System requirements

You must meet the following system requirements to scan using the Artec 3D scanners or third-party 3D sensors. The sensors need Artec Studio Ultimate edition to function.

<table>
<thead>
<tr>
<th></th>
<th>Windows</th>
<th>64 bit processor</th>
<th>RAM1</th>
<th>Graphics Card</th>
<th>Interface</th>
</tr>
</thead>
<tbody>
<tr>
<td>L2 EVA Spider</td>
<td>7/8 - x64</td>
<td>Intel Core i5/i7</td>
<td>8–12 Gb</td>
<td>NVIDIA (GeForce 400 Series or better) or ATI2 – both at least 1 Gb of memory</td>
<td>2 x Ethernet</td>
</tr>
<tr>
<td>Primesense Carmine and ASUS Xtion</td>
<td>7 - x64</td>
<td>2.66 GHz or faster (dual-core)</td>
<td>12–18 Gb</td>
<td>2 Gb</td>
<td></td>
</tr>
<tr>
<td>Kinect v1</td>
<td>2Gb</td>
<td>DX 9.0c support</td>
<td>—</td>
<td>—</td>
<td>USB 2.0</td>
</tr>
<tr>
<td>Kinect v2</td>
<td>8/8.1 x64</td>
<td>3.1 GHz or faster (physical dual-core: 2 logical cores per physical)</td>
<td>4 Gb</td>
<td>DirectX 11 support</td>
<td>USB 3.0</td>
</tr>
<tr>
<td>Intel RealSense</td>
<td>—</td>
<td>Intel Core (4th Generation and future)</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
</tbody>
</table>

Consider additional points below:

Real-time fusion mode (subsection 2.2.9): ensure your graphics card supports OpenCL 1.1 and higher.

Scanning with several scanners (Section 6.2) requires your workstation to feature as many independent USB 2.0 host controllers as there are devices connected. Upgrading your hardware with PCI/PCI-Express USB 2.0 cards may provide the required number of hosts.

Stereo mode in Artec Studio: if you plan to view models rendered in 3D on stereoscopic displays, you need NVIDIA Quadro professional graphics card that supports OpenGL Stereo. Since these graphics cards are not recommended for using with Artec 3D scanners, consider buying a dedicated workstation.

---

1 The more memory, the better.
2 AMD FirePro M6100 FireGL V and Intel graphics chipsets are not supported.
3 If you are adding USB 3.0 functionality to your existing PC through an adapter, please ensure that it is a Windows 8 compliant device and that it supports Gen-2.
**Note:** Windows Vista, XP or earlier versions of operating systems are not officially supported, so 3D Scanner might not properly work in these operating systems.

**Note:** At the moment we can not yet guarantee a correct performance of EVA scanner in a USB 3.0 port, but research shows that certain hardware combinations like Intel(R) 8 series USB controller perform very well. Please note that USB 3.0 is not recommended for Spider scanner.

### 1.4 Conventions and acronyms

- Text containing important information is highlighted as follows:

**Note:** Important information

**Warning! Practices to be avoided**

- Shortcuts, individual keys and hardware buttons are grayed out, e.g. `Ctrl + A`.
- Buttons on panels, in application menus, and icon names are in blue and italicized: `Invert`, `Fusion`, ...
- The names of panels and elements in the application window are highlighted in this way: `Workspace`, `File`, `Texture`, ...
- **LMB** — the left mouse button.
- **RMB** — the right mouse button.
- `▶` — `Play/Pause` button on the scanner body.

### 1.5 Glossary

- **Frames** — 3D surfaces captured by the scanner during a scanning session. Maximum scanning rate is up to 15 frames per second (up to 30 frames per second for 3D sensors Microsoft Kinect, ASUS Xtion and PrimeSense Carmine).

- **Key frames** — frames used by the global registration algorithm. They are selected automatically in a way that the surface of a captured object is fully covered while keeping their number at minimum.

- **Scan** — a sequence of frames captured in a single continuous movement of the scanner around an object or scene.

- **Project** — a method for managing the scanned material, processed data, user operations history in the computer memory or disk. The application Artec Studio project files have SPROJ extension.
• **Registration:**
  - **rough** – preliminary frame alignment performed at the stage of capturing;
  - **fine** – a more thorough frame alignment using an algorithm for relative positioning of sequential frames in pairs;
  - **global** – algorithm for optimizing relative positions of all frames in a single coordinate system.

• **Bundle** – capturing an object by simultaneously using several scanners, with their numbers and relative positions specified in the application;

• **Near and far cutting planes** – planes limiting the area of space in which the scanner is capturing 3D frames: the device will ignore everything that is closer than the near and farther than the far cutting planes.

### 1.6 User’s account

To install and keep *Artec Studio* up to date, customers should use my.artec3d.com site. It also allows them to keep track of all Artec devices and products they have. So to be able to work with *Artec Studio* and/or Artec 3D Scanner, customers have to be registered on the site.

By registering at my.artec3d.com, customer gets an account that is valid on all Artec sites and services (now includes my.artec3d.com and www.viewshape.com).

![my.artec3d.com welcome screen](image)

Figure 1.2: my.artec3d.com welcome screen

To register, you need to follow these steps:

1. Go to my.artec3d.com and click **Sign up** or click **here**.
2. Fill all the fields in Registration form and click **Create account**.
3. A confirmation link will be sent to the email address that you have entered during registration.
4. By clicking the link in your email, you confirm your registration and get straight into your account on my.artec3d.com site.
1.7 Scanner activation

Before using your new Artec 3D Scanner, you need to activate it and link it to an account on my.artec3d.com. This is done with the help of Artec Installation Center—a standalone utility available for download from my.artec3d.com. If you are a new user and do not have Artec Installation Center installed, please read the next subsection 1.7.1. Otherwise, you may skip it and go to subsection 1.7.2.

**Note:** Do not connect your scanner to the USB port before installing Artec Installation Center.

1.7.1 Artec Installation Center installation

To perform Artec Installation Center installation, please make sure that you have a computer connected to Internet. That may be any computer with USB2.0 or USB3.0 ports. You will be able to install and activate Artec Studio on a separate computer later. Please also make sure that you already have my.artec3d.com account, otherwise see Section 1.6.

Log into your my.artec3d.com account and download Artec Installation Center. Link for Artec Installation Center executable can be found on the main screen of the site as shown on figure 1.3a.

Open the folder, where the file was downloaded to, and run it and follow the instructions on the installation screens. Once Artec Installation Center is installed, you will see a dialog with login/password. Use your my.artec3d.com account to get logged in as shown on figure 1.3b.

1.7.2 3D Scanner activation with Artec Installation Center installed

To activate 3D Scanner through Artec Installation Center, you need to have your computer connected to the Internet and to make sure that Artec Installation Center is installed on it.

1. Run Artec Installation Center (that can be done through Start menu: Start → All Programs → Artec Group → Artec Installation Center/) and you will see window as displayed on figure 1.5a.

2. Connect your new Artec 3D Scanner to the computer and wait till Windows detects the device and installs its drivers. You may see a notification similar to one shown on figure 1.4.
3. Go to AIC, click Refresh and wait for the new 3D Scanner in the Hardware box to appear (see figure 1.5a). Click Activate (on the right side of S/N) to activate your 3D Scanner. If everything goes well, the status of the 3D Scanner will be changed to Activated as on the figure 1.5b.

![Activate button for 3D Scanner](image1.png)

(a) Activate button for 3D Scanner

![3D Scanner activated](image2.png)

(b) 3D Scanner activated

Figure 1.5: Artec 3D Scanner activation

### 1.8 Artec Studio Installation

There are two ways to download and install Artec Studio:

- Install it through Artec Installation Center (either during Artec Installation Center installation or by pressing Install as it is shown on figure 1.6);

- Download it from my.artec3d.com – log in the site, go to My applications page and download executable (see figure 1.7).

![Artec Installation Center](image3.png)

Figure 1.6: Artec Installation Center is ready to install Artec Studio

If your executable is downloaded from the server, you will need to run it, otherwise press Install in Artec Software Downloader window of Artec Installation Center after it is downloaded from
the server. To continue with the installation, click Next and proceed to the License agreement (figure 1.8a). After reviewing it, confirm your acceptance by clicking Yes.

Specify the path to the installation folder (we recommend to leave the default location) as shown on figure 1.8b and proceed to the window of selection components to install (see figure 1.8c):

- **Program Menu shortcuts** – create icon in the Start menu;
- **Desktop shortcut** – create icon on the desktop;
- **Start Menu shortcut** – shortcuts in Start menu and Quick Launch panel;
- **English manual** – installation of user manual in English;
- **Install Artec Scanner Drivers** – installation of drivers for Artec 3D Scanners;
- **PrimeSense Carmine / ASUS Xtion drivers** – installation of drivers for PrimeSense/ASUS Xtion third-party 3D sensors.

By default, the application will create all of the above icons, install the user manual and Artec 3D Scanner drivers. To continue with the installation, click Next.

If you do not have AIC installed, you will be presented with login/password dialog as shown on figure 1.3b. If you are not connected to the Internet, please read subsection 1.9 about offline activation of Artec Studio.

If the computer that Artec Studio is being installed on have not previously been linked with your account, you will see activation confirmation dialog as shown on figure 1.8e.

When the installation is complete (figure 1.8f), the installer will offer you to launch Artec Studio application.

1.9 Offline activation

If the computer you are installing Artec Studio on does not have an Internet connection and cannot be connected to the Internet for security or other reasons, then you can use Offline activation procedure to activate a copy of Artec Studio.

**Note:** Computers activated offline can not be deactivated later, so use this option only if you have no other choice.

**Note:** Before carrying out offline activation, it is vital to make sure the scanner (see subsection 1.7) and Artec Studio are tied to your account at my.artec3d.com.
Figure 1.8: Installation process

For offline activation you need to have:

- another computer connected to the Internet;
installation package of Artec Studio (it’s better to download it from my.artec3d.com);

flash drive or any other media to copy files to and from the computer not connected to the Internet and the one that does.

![Login/password dialog](image1.png) ![Offline activation window](image2.png)

Figure 1.9: Offline activation

Installation and activation procedure:

1. Start Artec Studio installation.

2. During installation the login/password dialog will be displayed as shown on figure 1.9a. Then click **Activate Offline...**

3. Offline activation dialog will be displayed (figure 1.9b). Click **Save...** and save generated ActivationID file to the flash drive.

4. Log into your my.artec3d.com account and open My applications page using the computer connected to the Internet.

5. Find Artec Studio product and click on it. A new page will appear as shown on the figure 1.10.

6. Click **Activate application offline** link, click **Select file** button and specify Activation ID file path. Then click **Activate**.

7. New dialog will appear allowing you to download Offline Activation Data file, which has to be stored on the flash drive.

8. Return to the computer with installation, click **Activate and Continue** and specify Offline Activation Data file.

**Note:** Once the Activation Data File is created, my.artec3d.com will decrease the number of activations available to you by 1.

If all the steps mentioned above are correctly completed, you will have your copy of Artec Studio activated on the computer not connected to the Internet and all your Artec 3D Scanners installed on this computer, too.
Note: If later you purchase another Artec 3D Scanner, you will need to reinstall the application and repeat activation procedure as described above in order to have the new scanner’s data files copied onto your computer.

1.10 Deactivation

Please note that deactivation is only possible for computers activated online as described in Section 1.8 and is impossible for the computers activated offline.

Note: Number of deactivations may be limited, so deactivate only if you really have to move Artec Studio from one computer to another.

To deactivate a license on your computer follow the steps:

1. Make sure the computer has Internet connection.

2. Go to Control Panel/Uninstall Applications and click on Artec Studio. Uninstallation process will start.

3. You will be presented with a dialog as shown on figure 1.11. Select the I understand. Please deactivate this computer checkbox.

4. Click Next and finish the uninstallation.
1.11 Managing Artec 3D Scanners and Products

*Artec Installation Center* application is used to manage Artec applications and 3D Scanners installed on the computer.

*Artec Installation Center* is a multifunctional part of *Artec Studio* that keeps connected with my.artec3d.com service and helps you to install new applications, download updates and manage 3D Scanners that you own or use. Being logged in is a necessary condition for launching *Artec Studio*. This is a one-time action, so your login and password will be requested only once.

When the *Artec Studio* launches, *Artec Installation Center* checks for new updates on the server and, in case an update of any installed product is available, it will display a notification message like the one shown on figure 1.12.

![Figure 1.12: Update is available on a server](image)

Once logged in, you may see various information about your products displayed by *Artec Installation Center*.

![Figure 1.13: Artec Installation Center](image)

The *Software* section of *Artec Installation Center* provides you with all information about your software products:

- A list of all applications available to you.
- Activation status of each application (application may be either activated or not).
- Number of activations you have in total and number of activations you’ve used so far.
- *Activate*, *Install* or *Update* buttons will be available in case any of these actions can be done.
  - *Install* – appears if the software is not installed on the computer (installation usually means activation).
○ *Activate* – appears if the software is not activated on the computer for some reason. Activation depletes number of licenses only once for each computer.

○ *Update* – appears if a new version of installed software is available on the server.

![Activation data for software product](image)

Figure 1.14: Activation data for software product

From the context menu of each software product there can be displayed an Activation Data window which contains data that may be requested by customer support such as Computer Name and Fingerprint (figure 1.14).

The *Hardware* section contains a list of the scanners that you own or just have connected on the computer. In the first case Activated status or *Activate* button will be displayed, while in the second there will be Rented status or *Rent* button.

There is a row of buttons at the bottom of *Artec Installation Center* window:

- *Refresh* button – is used to refresh data displayed by *Artec Installation Center*.

- *Close* button – is used to close *Artec Installation Center*.

### 1.12 Getting started with Artec Studio

#### 1.12.1 Main window

You can launch *Artec Studio* application in one of the following ways:

- using the desktop icon;

- by clicking the *Start* menu and following the path *Start* → *All Programs* → *Artec Group* → *Artec Studio* → *Artec Studio Professional/Ultimate 10*.

Upon the launch you will see the main application window, where all operations with models of scanned objects are performed. The application’s main window is divided into several sections (see figure 1.15): *3D View* window, *Tools* toolbar with one optionally open *Tool panel* on the left, *Workspace* panel on the right and *Log* window. Other windows may appear temporarily as well.

All 3D data is displayed in the *3D View* window. This is one of the main windows you will work with. When the application is launched, a coordinate grid and coordinate axes will appear in the center. This is the global coordinate system within which your scans and models exist.

To the left of the *3D View* window, you will see a side panel with icons for various application modes like: *Scan, Editor, Tools, Align, Edges, Repair, Measures, Multi, Texture*. All modes are mutually exclusive, meaning that the application can work only in one of the modes at any given time. Most of the modes will lock the *Workspace* panel when you open them. The main application modes are the following: *Scan, Editor, Tools, Align*.

At the top of the *3D View* window there is a context dependent *3D Tools* panel. The panel contains the following commands: *Home, Fit to View, Grid On/Off, Light On/Off, Color, Render*.
Figure 1.15: Main window of Artec Studio software

Mode, Shading, Backface. In Editor mode the following additional tools appear: Select Through, Positioning, Move/Rotate/Scale, Smooth Brush, Eraser, Defeature.

The Workspace panel is used to display and manage all the data uploaded into the application. Here you will find your scans as well as project manipulation commands, such as saving, erasing, moving, renaming. The hidden Workspace panel can be displayed using the button at the top right of the 3D View window (figure 1.16).

Figure 1.16: Button for Workspace panel display

Log panel is located at the bottom of the application window. The log is the application’s report on the commands executed specifying the time and details of the operation. The Log stores error and troubleshooting messages generated by the algorithms.

The application’s status bar contains information on RAM availability and current RAM usage. It also displays the progress indicator for the current task in progress, such as algorithm execution, model and scan exporting, etc.
1.12.2 Primary settings

To access the application’s settings dialogue, select Settings... in the File menu. The settings window has several tabs for various groups of application settings. For switching between the tabs, press the icon at the top of the dialogue. For a detailed description of the tabs see Section 7.

![Figure 1.17: Language selection through Settings.](image)

Under the General tab you can select settings to enable autosaving for the project before running each algorithm.

Under the Performance tab you can specify the number of alterations to be saved or specify the volume (in MB) of the history to be saved. The Data Compression Level slider helps to adjust the level of compression when saving the project data on a disk.

To change the language select Language tab (figure 1.17). After choosing your language from the list, click OK. The program will ask to confirm the operation and restart the application. Your consent will automatically restart the application with the new interface language, but all unsaved data will be lost. If you choose not to restart, the changes will be applied at the next start of the application.
Chapter 2

Scanning

2.1 Preparation

2.1.1 Connecting the 3D Scanner

Perform the following steps to connect the scanner: plug the scanner into a power outlet and insert the USB connector(s) into the USB port on your PC. LED indicator of Artec scanners (EVA, Spider) lights up with steady blue color for a short time signifying that it is booting up (see Appendix A for a full list of color indications).

Keep the following in mind when connecting:

- Disentangle scanner cables and keep them away from your feet. Tripping while working may cause physical injury or damage to the device.

**Warning!** *Do not connect other devices to the same USB controller in the PC. It may cause decrease in scanner capture rate and even shutdown of the 3D scanner.*

- To save computer resources while using the scanner, close other resource-intensive applications.

2.1.2 Algorithm settings

Taking into account dimensions and configuration of the target object or its area, choose the scanner model that would be most convenient for this session (see subsection 1.2), and connect it. Start the *Artec Studio* application. Scanner type (S, Spider, M, L or Third-party 3D sensor) will be automatically selected, according to the device being connected. Each particular set of settings corresponds to a certain scanner type and can be accessed through the *Scan* tab of the *Settings* dialog (figure 2.1).
2.1.3 3D Scanner setup

Click the Scan tab on the Tools panel. The panel that opens (figure 2.2) allows you to:

- Choose the type of tracker for current session.
- Specify the operating zone boundaries in millimeters.
- Select **Continue scanning from scans selected in workspace** checkbox if you have several scans captured with Geometry + Texture tracker and want to continue scanning the same scene. This option ensures that the new scan will be aligned with the selected ones if you start new scanning session from capturing already scanned region.
- Adjust the **Sensitivity** (for Artec 3D Scanners only). The normal value of sensitivity guarantees that the measurements are the most accurate but you may experience difficulties while measuring low reflective surfaces. Larger values of sensitivity allow measuring the larger extent of a surface even though with worse reflectivity but at the expense of higher noise level.
- Change the capture rate (number of frames per second). Values that ensure comfortable scanning with smooth movements are within the range of 7-15 frames per second.
- Select or clear **Don’t record texture** checkbox (it is only available for scanners with texture camera).
- For Artec 3D scanners equipped with texture cameras, adjust **Texture brightness** when in **Preview** mode.
- Trigger a capturing mode with simultaneous recording of scanning results to a disk by checking **Back copy scan data on disk**. This option is enabled when you work with already saved project (see subsection 4.2), it can be useful when capturing a large amount of data on a computer with insufficient RAM.
- Specify a number of seconds before Recording start by setting **Delay before recording** value. The countdown begins as soon as **Record** button is pressed. To remove the delay set the number to zero.
- Enter your own values in **Prefix** and **Start with** fields if necessary. These values will be used to create a scan title in the **Workspace** panel (see figure 5.2a). Default values “Scan” and “1” can be changed, for example, into “Capture” and “14”.

![Figure 2.1: 3D scanner type](image)
Figure 2.2: Scan panels

(a) Artec 3D Scanner is connected
(b) PrimeSense Carmin is connected
To start a pre-configured scanning process, press either Preview button or F7 on the keyboard or ▶ button on the scanner body.

2.2 Using 3D Scanner

2.2.1 Scanning algorithms and trackers

Starting from the Artec Studio version 8 and higher, different types of 3D Scanner position tracking algorithms have been added for user’s convenience. Those algorithms are required to calculate 3D Scanner position in the coordinate system relative to the scene being scanned and are best applicable to different types of objects. If you do not want to spend too much time tweaking algorithm settings, the general rule of thumb is to use Geometry + Texture tracker algorithm with 3D Scanners that are equipped with a texture camera (such as MHT, EVA, Spider).

The following options are available:

- **Geometry + Texture tracker** – the optimal and default algorithm for 3D scanners equipped with a Texture camera. It uses features found on the images got from Texture camera as well as geometrical features of the object and, thus, is less likely to fail on flat or textureless objects. The only possible drawback is higher than other algorithms CPU requirements that may cause decreased FPS on weak computers. It can be used with MHT, EVA, Spider or third-party 3D scanners.

- **Geometry tracker** – default algorithm for all 3D scanners that are not equipped with a texture camera. It uses only geometry of the object being scanned for alignment of frames. It is, thus, suitable for objects with rich geometry and is not recommended for usage on objects with big flat, spherical or cylindrical parts.

- **Targets tracker** – special algorithm for scanning objects with targets on their surfaces.

- **Real-time Fusion** – available both for Artec 3D scanners and third-party 3D sensors, this option produces fusion immediately after scanning. Processing is getting done on the GPU. It requires high-performance GPU processor and the latest video drivers to be installed in the system.

The rest of this chapter describes the principles of 3D scanning process with Artec 3D Scanners and third-party 3D sensors, the differences between tracker algorithms and the situations in which they are best applicable.

2.2.2 Common scanning principles and basics

The Artec 3D scanner captures objects at the rate of 15 frames per second. This is enough to ensure overlapping of adjacent frame areas as the scanner is moved gradually. Features found on overlapping areas are used for automatic alignment of the captured frames. Frame alignment is performed at the time of scanning and the user has an immediate access to the aligned frames displayed in a single coordinate system. You can assess the scanned area after the scanning session and see which parts of the object require additional scanning.

The 3D scanner has near and far cutting planes that determine the optimum distance between the scanner and the target object. If you stand too close to the object while scanning, it will not be captured. When the scanner is too far from the object, the surface becomes too noisy, complicating 3D model processing and adversely affecting the end result. This is why you should
place the scanner as close to the object as possible while not crossing the near cutting plane (figure 2.3).

Figure 2.3: Surface cut off by the near cutting plane and range meter

*Range meter* is available in *Artec Studio* during scanning process for easy visualization of the distance between the scanner and the object. It constitutes a set of semitransparent diagrams located on the left part of *3D View* window (figure 2.3). Each histogram displays distribution of captured surface points by distance to the scanner. Histogram color corresponds to surface sets for which it was obtained: by default, gray color is used for registered key frames, light green is used for the last few frames of a registered sequence, dark green is used for the last successfully registered frame, and red indicates a registration error.

**Note:** You can change the colors in Settings under the *UI* Tab. See subsection 7.4.4

The lower limit of the *Range meter* scale corresponds to the near cutting plane, while the upper limit to the far cutting plane. In order to get the best results, watch the histogram values and do not cross the preset limits as well as position a device closer to the lower limit.

Figure 2.4: Redefining scanning depth range

By default, *Artec Studio* knows correct values of minimum and maximum limits, within which cut-off planes are to be positioned. These values are different for each model of 3D Scanner and ensure good quality of the 3D data captured. If high accuracy is not of great importance, depth boundaries can be adjusted manually, which will allow the user to scan with L scanner or 3D sensors closer to or further from the recommended distance to the object. To do it, select *Override default depth range* checkbox in the settings dialogue on Scan Tab, then specify new boundaries for the scanning range (figure 2.4). For more details about scanning settings, see subsection 7.3.3.
Note: Redefining the recommended depth range may result in loss of accuracy.

Losing and resuming tracking

When scanning, bear in mind that moving the scanner too fast may cause overlapping areas of adjoining frames to become too small, so the application will not be able to automatically align the new frame with the previous one. In this case, scanning will halt and the system will switch to waiting mode until the scanner captures a frame that can be well aligned with the preceding sequence. All new frames which cannot be positioned correctly relative to the previous frame will be discarded and not included in the new scan being created. In that case the screen background will become red and a notification message will appear, alerting the operator to return the scanner to the previous position and try to either move slower or add additional geometry or texture objects (shown on figure 2.5). At the same time, the system notifies about the error by recurrent alarm, which stops when the error is eliminated (the audible alarm can be enabled or disabled under the UI Tab in the settings dialog, see subsection 7.4.1).

Figure 2.5: Message about lost tracking

Once the system locates the correct position for the new frame, scanning will resume. For this to happen, the operator has to align the previous frames with new frames by moving the scanner to the last recorded area. Sometimes this may prove difficult, in which case it may be easier to restart the scan. Although, if you are scanning with Geometry + Texture tracker, the Auto-alignment during the scanning option may ease the process:

- Being enabled in the application settings (subsection 7.3.3), this option after three seconds switches the Tracking is lost mode (figure 2.5) into Searching for position followed by the message on a green background.
• In order to continue scanning, point the scanner at any already captured region (not necessarily the last captured one).

**Note:** If the software successfully picks the tracking up, a new scan will be created.

• Recording will resume in a newly created scan. This new scan will be already aligned with the previous one.

**Misalignment detection**

In some cases the relative position of frames may be determined incorrectly, resulting in their misalignment. If this is the case, you have to restart the scanning session and remove the misaligned scans. You may also try to fix the result of a misalignment by breaking the scan into several scans. Fixing this problem by breaking scans is described further (subsection 5.1.1). In order to prevent possible misalignment, Artec Studio 10 features the Misalignment detection for EVA scanner option, that works during the scanning procedure itself. If you noticed that it became difficult to maintain the tracking when scanning particular objects, you can disable this option in Settings (subsection 7.3.3).

**Continue scanning from scans selected in Workspace**

Auto-alignment is a great timesaver and may help to simplify further processing. But if you have a project with scans captured with Geometry + Texture tracker and the actual scene has not been changed, you can continue scanning as if it has not been paused.

1. Make sure the Auto-alignment during the scanning option is turned on in settings (see subsection 7.3.3).

2. Mark previously captured scans with ☒ icon in the Workspace panel.

3. Select Geometry + Texture tracker and the Continue scanning from scans selected in workspace checkbox in the Scan panel.

4. Click Preview, point the scanner at the already captured region, and then click Record button.

5. If the tracking is successfully resumed, the newly recorded scan will be aligned with the selected ones.

**2.2.3 Notes on scanning with Spider scanner**

It is advisable to use Spider scanner after it reaches its operating temperature. As soon as you connect scanner to PC or plug it in, it starts warming. If you open Scan panel, two lines appear, among others, on it notifying you about current and optimal temperatures of the device. Warming is faster when scanner is in Preview mode. Scan panel also displays additional information about the time left for scanner to reach its optimal temperature.

**Note:** Spider scanner can be used as well at the temperature that is out of the optimal range. Although the accuracy of surfaces obtained is not guaranteed in this case.
2.2.4 Notes on scanning with Third-party 3D sensors

**Note:** Third-party 3D sensors are only available in Artec Studio Ultimate.

Third-party 3D sensors (Appendix G) have not specially been designed to be used as 3D scanners. Being multipurpose devices made from cheap components, they do allow to scan objects, but the quality of texture and surfaces obtained is far worse than with professional Artec 3D scanners (figure 2.6). Operation ranges and fields of view of all supported in Artec Studio Ultimate third-party sensors are shown in figure G.2. The actual values may slightly differ for a better scanning experience.

When scanning with these 3D sensors, bear in mind the following:

**Providing good lighting is your responsibility** because neither of sensors features built-in flash. It is also impossible in this mode to adjust brightness of texture being captured. That is why good lighting is crucial for obtaining a decent model. Do not illuminate the object excessively, avoid using direct light and luminescent lamps.

**Use a special technique with Primesense and ASUS Xtion sensors** for obtaining surfaces of consistent brightness:

1. Click *Preview* button (see figure 2.2b).
2. Point the sensor at the object and hold it for 5 seconds while it adjusts white balance and exposure.
3. Then click the *Record* button.
4. Do not move the scanner fast.
5. While scanning, keep the sensor as close as possible to the object.

**Most of the devices work in the Real-time fusion mode, except for Kinect v2.**

![Figure 2.6: Scans obtained and processed](image)

**2.2.5 Long-distance scanning with Kinect v2**

*Kinect v2* features extremely large operation range (figure G.2). In order to benefit from it, you have to change settings listed below.
Note: Surfaces obtained at these long distances may lack detailed representation of features of even not too small sizes.

- Access application Settings, open Scan tab (figure 7.5).
- Select the Override operation range checkbox and set the Far (mm) plane value to 5000.
- Then clear the Use default realtime settings checkbox and set the following:
  - Triangle Step to 1;
  - Length Filter Threshold to 100.

Now everything is ready for a long-distance scanning.

Note: Before you start processing the scanned data with Global registration (Section 5.3), set the local_align_thr parameter to 5.

2.2.6 Notes on scanning with MHT scanner

The flash in MHT scanner has a very large, yet limited number of operation cycles, so make sure you disable the scanner when not using it. Do not leave the scanner MHT on for a long time when the maximum capture rate is activated (15 frames per second). The Artec Studio application will automatically turn off the scanner MHT after 5 minutes of continuous operation. Normally active mode/rest mode is 3/7, so 3 minutes scanning and 7 minutes of rest. This operating mode is optimal and it significantly increases lifetime of the flash.

2.2.7 Scanning with Geometry + Texture tracker

Geometry + Texture tracker tracker is only available for scanners with texture camera and is set as default. It allows registration algorithm to track and align scans using both texture and geometrical features of the object that is being scanned. Using the Geometry + Texture tracker ensures the best possible results, allowing you to move your scanner faster while scanning, and leaving less work for manual post-processing of the end result. In order to make the most of this tracker, do not turn off the Auto-alignment during the scanning option in the application settings (subsection 7.3.3).

While scanning in both preview and record mode with this tracking algorithm, you will see already textured objects.

Note that you may specify the frequency of capturing texture frames by using the appropriate spinner in Settings dialog (see subsection 7.2.5 and figure 2.8).
In *Preview* mode *Texture brightness* can be adjusted. Using slider you can increase or decrease brightness of frames captured by color camera (see figure 2.9).

The Geometry + Texture tracker is especially useful in the following cases:

- When scanning objects of complex forms (with geometrical and textural features);
- When scanning flat surfaces without unique geometry;
- When accuracy is important.

Being a universal tracker, it is most useful when scanning both geometry-rich objects and flat textured areas. The Geometry + Texture tracker does save your time and it is the easiest way to scan objects with Artec 3D Scanners.

**Note:** The Geometry + Texture tracker, however, requires more CPU resources, so we strongly advise you to check the recommended computer configuration in subsection 1.3 before purchasing a computer.
In case your system is not powerful enough and scanning with Geometry + Texture tracker decreases scanning FPS, you may switch to other trackers in order to reduce resource consumption of your PC.

**Turning scanner flash off**

If you are not allowed to use scanner flash due to some rules, requests or some other reasons, you may follow the directions below.

Note that disabling flash should be compensated by bright ambient light. According to our tests, texture of acceptable quality can be obtained with disabled flash if the surface illuminance is
not less than 1000 lux. Compare the models (see figure 2.10), captured in poor lighting conditions and in good lighting conditions.

The following steps should be performed to get the textured model without using scanner flash:

1. Open Scan panel, click Advanced link.
2. Turn off the texture flash by selecting the Disable flash bulb checkbox.
3. Set good illumination. Do not use luminescent lamps.
4. Press Preview and point the scanner to the object.
5. Adjust Texture brightness and Texture exposure time. In most circumstances values should be as minimal as possible, because increasing Brightness leads to noise occurrence, while increasing exposure time can blur the texture. Instead of adjusting sliders try to improve even further the light conditions.
6. When you have finished, perform required post-processing as described in Chapter 5 and get a textured fusion.
7. Adjust texture parameters for this fusion as described in subsection 5.8.2. Particular attention should be paid to Hue and Saturation sliders. Using Hue slider, you can correct unwanted color of texture.

2.2.8 Scanning with Geometry tracker

Geometry tracker is the only tracker that is available for all Artec 3D Scanners, regardless of if it has a Texture camera or not. This tracker uses only geometry of the objects to align the frames of the scan during scanning. Amongst the other trackers, it is the least CPU-hungry one and it is most suitable for scanning all sorts of objects that have any geometrical features in the field of view of the scanner.

Figure 2.11: Main window during scanning with Geometry tracker
Note: Geometry tracker is especially useful, when it is known that the object being captured is unique enough from geometry point of view, so there is no actual need in texture tracking. The color information may be captured while using Geometry tracker, if you have a scanner equipped with a texture camera. The post-processing speed of the data captured with Geometry tracker is highest among all other types of trackers available in Artec Studio.

Geometry tracker is frequently used for human body and sculpture scanning. The list of objects that can be scanned with Geometry tracker only is very impressive due to the fact that Geometry tracker does not use texture for alignment of scans. However, it may be hard to scan some objects. In this case, it is recommended to use other trackers or, if your Artec 3D Scanner model does not have a texture camera, use approaches described in subsection 2.2.11.

2.2.9 Scanning with Real-time Fusion

Real-time fusion is a special mode when the Artec Studio stitches together the 3D frames being obtained in real time, while the scanning is going on. The Real-time Fusion is available for each tracker. All processing operations are performing on the GPU. When you finishes with the scanning, you will get a fused object (model) immediately.

You can access the Settings window and use the Performance tab to configure the following Real-time Fusion settings (see subsection 7.2.6).

1. **Voxel size**, in other words, resolution, i.e. the size of the triangulation grid step in millimeters

2. **Dimensions** is a side of cube, which defines scanning zone. Due to real-time processes performing it is not recommended to enlarge dimensions unless necessary.

Note: Adjust two parameters in couple. For instance, being constrained with small amount of GPU memory, you can increase one parameter while decreasing another. That is the way you can optimize GPU memory consumption.

![Figure 2.12: Workspace panel after Real-time Fusion](image)

When scanning is finished, two new objects for each scan made during the session will be added in the Workspace panel. The objects’ names will look like “Scan1” and “Scan1-Fusion” (see figure 2.12).
2.2.10 Scanning with targets (Scan Reference)

Scanning based on combination of special reference targets and photogrammetry measurements results allows users to scan big areas at a time, improve the accuracy of obtained surfaces, and boost productivity by reducing post-processing time. The only disadvantage of the method is the necessity of preparations. But when finished with scanning, you do not have to align the scanned surfaces, so you can at once proceed to the Fusion (see the order of post-processing steps in 3D Scanning at a Glance).

Such a synergy of technologies is possible due to using of Artec 3D scanner and photogrammetry solutions. There are several third-party photogrammetry solutions on the market. Scan Reference photogrammetry is one of those solutions. Scan Reference Kit includes: software and hardware (see figure 2.13a): digital camera, reference scale cross, non-coded sticky targets (used by the Artec Studio in order to match the 3D data obtained to the photogrammetry measurements results), re-usable magnetic coded targets (required for automatically carrying out the measurements in the Scan Reference software).

![Scan Reference Kit and targets.](image)

Figure 2.13: Scan Reference Kit and targets. (a) From left to right: coded targets (in the foreground), digital camera, scale cross, roll of tape with non-coded targets, case

Perform the following steps:

1. Prepare an object and a surrounding scene. All the objects must remain stationary during the measurements and the scanning.
   (a) Place the cross on the scene, make sure that it rests firmly and all targets on it are clearly visible.
   (b) Place the coded targets on the object and on surroundings. Note that they are to be distributed in such a way that at least 6–8 coded targets are bodily visible in each image. Random order is preferred, symmetry and alignment should be avoided.
   (c) Stick non-coded targets on the object using the following rules:
      i. Not less than 6 targets are to be within the scanner field of view. For instance, figure 2.13c shows 7 targets, but 2 of them will not count due partial visibility.
      ii. When choosing the place for targets,
         • Try to place them on flat elements;
         • Avoid unequal surfaces;
         • Do not hide significant geometry elements.
Note: The size of targets can be specified in the Settings dialog of the Artec Studio, as described in subsection 7.3.2. If you use non-coded targets from Scan Reference Kit, specify 5 mm for inner diameter and 10 mm for outer. Targets from another suppliers should be measured and both diameters values should be specified in the corresponding fields of the Settings dialog.

2. Take several photos of the object from different angles of view. Exact numbers of photos, angles and targets in each images, as well as required settings of calibrated digital camera can be found in Scan Reference User Manual.

3. Move the cross and the coded targets away from the scene.

4. Connect camera to PC, transfer and process photos in Scan Reference software. With the calculation successfully being completed, the measurement results are shown on the screen. These results can be represented as a point table or a 3D model.

5. Save point model in *.obc file. This format is default for the software.

6. Open Scan panel in Artec Studio application. Select Targets as Features to track.

7. Press Load targets from file and specify OBC file path.

8. Scan the object. When you finish, all the scans will be aligned.

2.2.11 Selecting and preparing objects for scanning

The Artec 3D scanner operation is based on the structured light 3D reconstruction method. This optical method allows digitizing a fairly large area of the object surface in a single frame. The scanner uses an incoherent light source to this end.

Since the method of capturing 3D frames is optical, certain types of objects are difficult to scan. These objects include:

- objects made of transparent materials (glass, certain kinds of plastic, etc);
- very dark objects and objects with a dark surface;
- shiny or reflective objects;
- objects with very fine details (e.g. hair).

However, there are techniques that allow successful processing of such objects. For example, a transparent or dark object can be painted over with a light paint, dusted with a powder. Other easily removable substances or a special anti-glare spray can also be used. As a last resort, you can make a plaster cast of the object and scan it. Do not be afraid to experiment and you will achieve the brilliant results.

2.2.12 3D Scanner buttons and capturing modes

Your 3D scanner may be in one of the following capturing modes (each of them is matched with LED indication on the body of Artec scanners):

- **Ready** – (the LED is steady green ■) is a mode when the scanner has either been detected by the application or the Stop button has been clicked in the Scan panel or the 0 button has been pressed on the scanner body (see figure A.1). In this mode 3D scanner is not flashing.
• **Preview** – (the LED is flashing red ![Illustration](https://example.com/)). In this mode images are being captured by the 3D scanner, but the alignment is not performed and captured frames are not recorded. It can be started by either Preview button in the Scan panel or by ![Corner](https://example.com/) button on the scanner body or by ![Corner](https://example.com/) key on the keyboard. This mode is useful for:
  - checking the field of view of the 3D Scanner,
  - preparing for capturing and further actions planning,
  - texture brightness adjustment.

• **Recording** – (the LED is steady red ![Illustration](https://example.com/)) in this mode scanning is going on with 3D data being stored on the disk or into the RAM. The mode can be activated either by clicking the Record button on the Scan panel or by pressing ![Corner](https://example.com/) key on a keyboard or by pressing ![Corner](https://example.com/) button (the first stroke is for Preview, the second one is for Recording).

To pause recording either click ![Corner](https://example.com/) in the Scan panel or press ![Corner](https://example.com/) on the scanner body or press ![Corner](https://example.com/) key on the keyboard.

**Spider** and **EVA** scanners are equipped with a three-position button (see Appendix A). **Preview/Recording/Pause** modes are activated by pressing the same button ![Corner](https://example.com/). **MHT** and **MH** scanners are equipped with one-position buttons, which are used for switching between **Recording** and **Pause** modes, the **Preview** mode can only be activated through the software panel (for details see table 2.1). If you want to record the 3D data by holding pressed the hardware button and pause by releasing it, clear the **Trigger mode for device button** checkbox in the settings dialog under the Scan tab (see subsection 7.3.3).

<table>
<thead>
<tr>
<th>Scanners</th>
<th>Preview →</th>
<th>Recording ←→</th>
<th>←→ Pause</th>
<th>→ Stop</th>
</tr>
</thead>
<tbody>
<tr>
<td>EVA, Spider</td>
<td><img src="https://example.com/" alt="Corner" /></td>
<td><img src="https://example.com/" alt="Corner" /></td>
<td><img src="https://example.com/" alt="Corner" /></td>
<td><img src="https://example.com/" alt="Corner" /></td>
</tr>
<tr>
<td>MHT, MH (trigger mode)</td>
<td>N/A</td>
<td>scanner button</td>
<td>scanner button</td>
<td>N/A</td>
</tr>
<tr>
<td>MHT, MH</td>
<td>N/A</td>
<td>hold scanner button</td>
<td>release scanner button</td>
<td>N/A</td>
</tr>
<tr>
<td>L, M, S</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
</tbody>
</table>

Table 2.1: Scanner buttons and corresponding modes

### 2.2.13 Scanning objects

When you have prepared the object for scanning and have connected the scanner to the PC, open the side panel **Scan**. If you have only one 3D Scanner connected to the computer it will be selected by the **Artec Studio** automatically, otherwise you will need to select the required one in dropdown list under the **Advanced** section of the **Scan** panel.

If you plan to use the scanning results in the future, it is recommended to create a new project before getting started by using button ![Corner](https://example.com/) in the **Workspace** panel, selecting **New project** in menu **File** or using shortcut **Ctrl + N**. When the project has been saved, you will be able to load or unload the scans as necessary, keeping RAM-usage under control (for details see **Chapter 4**).

When you are starting **Preview** mode, all the scans uploaded in the application become hidden. This mode lets you determine how well the 3D scanner sees the object and identify the areas that may cause trouble during the scanning session. To start the scanning process, press the **Record** button in the **Scan** panel or press the ![Corner](https://example.com/) button on the device body.

If for any reason you do not want the scanning to begin immediately after pressing the **Record** button (e.g. you need some time for scanner positioning), you should set a delay in seconds using...
the *Delay before recording* option under the *Advanced* section of the *Scan* panel. This will delay
the start of the recording session for a preset number of seconds after pressing the *Record* button.

**Note:** When recording was started by pressing the button on the device, the recording process
begins immediately without a delay.

If your 3D Scanner is equipped with a texture camera, the program will activate the texture
flash of the 3D Scanner and capture color images that later will be used for texturing of resulting
3D model.

**Note:** When capturing with Geometry tracker, texture flash will be activated not on every
frame, but only when significant movement is done.

After the scanning has been started, gradually move the scanner, while monitoring the process
in the *3D View* window.

If the object can be scanned from all directions at a time, capture its surfaces and click the
*Stop* button in the application window or press \(\text{\text{Home}}\) on the scanner body. If the object cannot be
scanned at a time, capture available part of the object and pause the session, clicking the *Pause*
button or pressing \(\text{\text{Pause}}\) button on the scanner body. Then you have to prepare the object for the
next scanning session, by turning it or by moving yourself towards the unscanned area, and click the
*Record* button or press \(\text{\text{Record}}\).

**Note:** Using a special third-party turntable would enable the operator to avoid interrupting
the scanning session and turning the object by hands.

**Note:** A new scan in the *Workspace* panel is created at the beginning of the session.

Having the object successfully captured from all sides, you can click the *Stop* button or press
\(\text{\text{Home}}\) on the scanner body.

**Scanning recommendations**

- When scanning, make sure the resulting scans have overlapping areas that will be later used
to align them.

- It is recommended to scan the object all the way around plus a little more (360+ degree).
If you can not go all the way around the object, then try to come back to the same point
where you have started.

- While scanning, avoid capturing any object that can change shape in the process of scan-
ing. For example, avoid scanning the operator’s hands. When the geometry of the scene is
changing, it is far more difficult (and sometimes absolutely impossible) for the system to find
the correct position of new frames relative to the previously aligned frames. If unwanted
objects have been captured, you would need to remove them later at the editing stage (see
subsection 5.1.3).

- When scanning, make sure the 3D scanner is located as close as possible to the object
without crossing the nearest workspace boundary. When the scanner is set too far from the
object the accuracy of scanning drops.
For best results, try to scan at a 90-degree angle to the target surface at all times. It is especially important to observe this rule when capturing dark objects.

- The accuracy of the scanner is better in the center of the field of view. So to achieve the best results, try to keep the object during scanning as close to the center of the field of view as possible.

- If the final model contains noticeable noise, this probably means that the affected area was not properly scanned. In this case it makes sense to rescan the affected areas.

- With the application in the Preview mode, we recommend planning the sequence of the upcoming scanning process and practice it. This will help you to determine the best position for the object, decide on the number of sessions required for capturing the whole object, etc.

### 2.2.14 Fine registration

*Fine registration* is a kind of automatically run algorithm intended to register captured frames precisely. While *Rough serial registration* works during scanning, *Fine registration* starts once the *Scan* panel is closed.

**Note:** *Being automatically run, Fine registration algorithm still uses settings specified in the Tools panel in the section of the same name.*

In a number of cases Fine registration algorithm can be manually started in the *Tools* panel. List of parameters can be accessed through button in the *Fine Registration* section. The algorithm affects all the scans marked by icon in the *Workspace* panel (see subsection 5.1.1 for more information on scan selection), but process them separately.

There are from to two to three parameters to specify:

- *registration_algorithm* – type of registration algorithm.
  
  - *Texture_and_Geometry* option takes both texture and geometry into account.
  
  - *Geometry* uses geometry only. Unless your scan does not feature any texture, it is not recommended to opt for this option.

- *refine_serial* is enabled by default for *Geometry* mode and available as an option for *Texture_and_Geometry* mode. This type represents the conventional algorithm of fine serial registration and registrates in-series captured frames.

- *loop_closure* is an advanced algorithm that registrates any frames not necessarily in-series captured. Based on the presence of common regions in these frames, it compensates a cumulative error (figure 2.14c) caused by the peculiarities of the movements of a hand-held 3D scanner. In *Texture_and_Geometry* mode it is highly recommended to enable this algorithm.

The figure 2.14 illustrates how both algorithms work independently. Callout boxes in each figure shows two frames of the same corner of door frame captured at the beginning and at the end of the scanning session. The data captured (figure 2.14a) has a cumulative error which can be noticed in the callout box. Serial registration algorithm improves registration (figure 2.14b), but misalignments still present. Loop closure algorithm eliminates these misalignment completely (figure 2.14c).
Figure 2.14: Fine registration algorithms
Chapter 3

Viewing 3D models

3.1 3D navigation

When scanning is finished, the results are displayed in the 3D View window.

3.1.1 Moving/rotating/scaling

You can control the observer’s position in the 3D View window by moving, rotating or zooming the observation point in or out. Use the mouse to control movement, rotation and scaling of the view.

Navigation methods:

- **Moving** – move the mouse pointer on top of the 3D View window. Hold down the RMB and LMB keys simultaneously, then move the mouse to relocate the model. The middle button can also be used for the same operation.

- **Rotation** – move the mouse pointer on top of the 3D View window. While holding down the LMB, move the mouse to rotate the model.

- **Zooming in and out** – hold in the RMB and move the mouse. Moving the mouse left or up will zoom the model out, while moving it right or down will zoom it in. You can use the mouse wheel to the same effect.

3.1.2 Setting rotation center

When you rotate the model, the scene always turns around a certain point, the rotation center. Three small coordinate axes will be displayed at this point (see figure 3.1). When you launch the application, the rotation center coincides with the origin of the main axis grid. To change its location, double-click the LMB at any point on the 3D model itself: the rotation center will move to this point. Setting the rotation center can be useful when you wish to view a particular object from all sides. In this case, set the rotation center on the object and rotate the view using the LMB.

Figure 3.1: Rotation center
3.2 Choosing projections

The View menu (see figure 3.2) allows you to choose between perspective and orthogonal projections for displaying the model in the 3D View window.

Perspective projection is the central projection on a plane produced by direct rays focusing in one point: the projection center. This produces a visual effect similar to human eyesight.

Orthogonal projection is produced when the projection center is infinitely distant from the plane of projection, the projection rays in that case fall perpendicular to the observation plane. This type of projection preserves parallel lines and is more commonly used for measuring purposes (for details see subsection 6.3).

Projection type can also be switched with:

- either Ctrl + 5 key combination on the main keyboard;
- or with 5 key on the extended numerical keyboard.

3.3 Viewpoints

To quickly toggle a camera view between several predefined positions, you can use View menu or keyboard combinations as defined in table 3.1.

Table 3.1: Key combinations for switching viewpoints

<table>
<thead>
<tr>
<th>Viewpoint</th>
<th>Keyboard</th>
<th>Extended Numpad</th>
</tr>
</thead>
<tbody>
<tr>
<td>Front</td>
<td>Ctrl + Shift + 1</td>
<td>1</td>
</tr>
<tr>
<td>Back</td>
<td>Ctrl + 1</td>
<td>Ctrl + 1</td>
</tr>
<tr>
<td>Left</td>
<td>Ctrl + Shift + 3</td>
<td>Ctrl + 3</td>
</tr>
<tr>
<td>Right</td>
<td>Ctrl + 3</td>
<td>7</td>
</tr>
<tr>
<td>Top</td>
<td>Ctrl + Shift + 7</td>
<td>Ctrl + 7</td>
</tr>
<tr>
<td>Bottom</td>
<td>Ctrl + 7</td>
<td>Ctrl + 7</td>
</tr>
</tbody>
</table>

3.4 Displaying 3D models

The toolbar at the top of the 3D View window features controls for data display modes. All the commands for viewing and switching between modes can also be found in menu View (see figure 3.2).

The button  Home (or menu View option with the same name) is used for restoring the view of its original position at the launch of the application.

The Fit to View command ( button or similar menu Fit to View) option is used to automatically fit the object on screen into the 3D View window.

For enabling/disabling global coordinate system axes select the Grid on/off option in menu View or by pressing the  button on the 3D View window panel.
3.4.1 Rendering and shading modes

You can choose one of the following 3D frame rendering options for scan frames in the View menu (see figure 3.3):

- **Render Solid** is the most common way of rendering with solid fill of all the faces using a selected shading method;

- **Render Wireframe** – displaying polygonal mesh edges without solid fill of the faces;

- **Render Points** – displaying polygonal mesh vertices;

- **Show Wireframe Over Solid** is a type of rendering which applies solid fill to the faces and uses a different color to display edges; can be used for visually assessing the polygonal model quality (for details see subsection 5.6.6);

- **Render Points and Solid** – scans are automatically displayed in point view, while models are shown in solid fill view. Using this mode there is no need for switching to other modes looking for the best rendering way for each type of the surfaces. This rendering way is enabled by default for Spider scanner.

All the rendering modes can be activated from the 3D View window toolbar by pressing the button for enabling the solid fill mode, – for displaying the wireframe model, – for displaying points model, – for displaying the wire over the solid fill, and – for displaying points or solid fill view model depending on the surfaces selected.

![Figure 3.3: Available rendering modes](image)

See figure 3.4 for some examples of using model rendering modes.

Also, you can use the 3D View window toolbar buttons to choose a shading method for the solid fill of the frame or select it from menu View.

- **Smooth shading**, button on the toolbar. With smooth shading, the color value for each point within a triangular face is calculated by color interpolation at the vertices.

- **Flat shading**, button on the toolbar. With flat shading all the points of the triangular face are assigned the same color.
3.4.2 Light, color, and texture

The Light On/Off option in menu View or button on the toolbar are used for turning the light on or off in the 3D View window. This option might be useful when you need to turn off the light for viewing only the outlines of the model or assess texture quality.

The Texture option in menu View is used for selecting the method for assigning colors to the scan frames. The following methods are available:

- **Texture** – displays textured data, otherwise the default color of the scan is used;
- **Scan color** – displays default color of the scan;
Surface color – each frame in a scan is colored differently;

Quality – the frames are colored in accordance with the quality of their registration, with red color indicating registration errors.

The listed options for assigning of colors to frames can be selected by pressing corresponding buttons on the toolbar: , , , (figure 3.6). Examples of using different options for color assigning are shown in figure 3.7.

![Figure 3.7: Various color modes for scan frames](image)

(a) Mode Frame color  (b) Mode Quality

3.4.3 Backface rendering

There are three methods for rendering the backface of the frame:

- Show – the backface of the frame is assigned the same color as the model;
- Cull – the backface is not displayed;
- Black – the backface is rendered black.
These modes can be selected in menu View or by pressing buttons $\text{Show}$, $\text{Cull}$ and $\text{Black}$ in window 3D View respectively (see figure 3.8). By default, mode Black is selected.

![Figure 3.8: Backface rendering options](image)

See figure 3.9 for some examples of backface rendering modes.

![Figure 3.9: Examples of backface rendering modes](image)

### 3.4.4 Representation of normals and boundaries

*Toggle normals On/Off* in menu View enables/disables rendering of normals for each vertex. By default, normals are directed away from the model surface and toward the 3D scanner. Direction of normals can be changed by using the *Invert normals* command. For more information on
When working with the edges, the **Toggle boundary On/Off** feature in the View menu can be useful for enabling/disabling highlighting of model’s edges. To enable/disable highlighting of model’s edges, use the **B** key with the 3D View window being active.

### 3.4.5 Rendering and texturing of non-textured polygons

Textured models might have some untextured areas (see white area in figure 3.10b). The **Polygons without texture on/off** option in the View menu allows turning on/off rendering of such areas.

![Figure 3.10: Correspondence between toggles positions and texture rendering](a) Polygons ... off  (b) Polygons ... on  (c) Polygons ... on and Wrap texture ... on

If the texture on the imported model is smaller than the entire model, it can be wrapped to fill the untextured areas (see figure 3.10c, notes on model importing see in subsection 4.5). The wrapping effect is similar to tiling the floor or pattern repeating on the wallpaper, i.e. texture is cyclically repeated. To activate this option turn on the **Wrap texture coordinates on/off** toggle in the View menu.

**Note:** Displaying of the untextured polygons must be activated, as described above, otherwise you will not see the wrapping texture (see figure 3.10a).

### 3.4.6 Displaying boundaries of texture atlas

As known, texture applied to 3D models is two-dimensional. You might want to see boundaries of each piece of texture on the actual 3D surface. Texture atlas file like the one shown in figure 5.35b can be represented mapped with its boundaries highlighted (see figure 3.11). Understanding the way the boundaries run over the surface may help you, for example, find out whether the model needs to get simplified for a better texture application.

To enable displaying boundaries, access View menu, then select **Texture boundary on/off**. To disable displaying, do the same and make sure this menu command is unchecked.
Technically, this command also works for textures produced by Triangle methods, but does not provide usable information.

### 3.4.7 Stereo mode

Stereo mode (the *Stereo mode On/Off* command in menu *View*) is used for operations with stereo displays and stereoscopic 3D-enabled equipment. To enable this mode, OpenGL Stereo must be supported. NVIDIA Quadro professional graphic card family is one example of such equipment. When the stereo mode is unavailable, the menu option will be grayed out.

For more information on compatible equipment see NVIDIA website.

### 3.5 Saving screenshots

Surfaces displayed in *3D View* window can be captured and saved in graphics file. Unlike conventional Windows *Print Screen* command, this option saves only *3D View* window’s contents (see figure 3.12) and ignores any background. The following objects are captured with the surfaces:

- coordinate axes;
- various points, lines and planes;
- annotations;
- surface distance maps and their histograms (see Section 6.3);
- measurement results: points, lines and labels see.

To create a screenshot, follow the procedure:

1. Select *Save screenshot* option in the *View* menu or press *Shift+Ctrl+S* key combination.
2. In the opened Explorer dialog specify destination folder and the file name and click *Save* button. The file is saved in PNG format.
Figure 3.12: Examples of saved screenshots

**Note:** Be aware that file name conflicts are solving through overwriting without any warning messages. Therefore, every time when you save screenshots, specify unique names in order to avoid these issues.
Chapter 4

Operations with projects

A project is a sum-total of the 3D data, collected during scanning and post-processing which can be saved on a disk and recovered in the future. In addition, a project contains measuring results obtained by user (see subsection 6.3).

A project is a disk folder which contains all the project data and a project file describing its structure.

4.1 Creating a project

It is recommended to create a project and to name it before scanning (see subsection 2.2.13). A new project can be created using the File - New project menu option, by pressing button at the top of Workspace, or by using a shortcut Ctrl + N. Then, in the project creation dialogue (figure 4.1) enter the project name and specify the path to the folder in which it will be saved. While working with a project, the name of the active project is specified in the header of Workspace window.

![Figure 4.1: Project creation window](image)

Creating a project is not necessary if you do not plan to process or use the scanned material in the future.

4.2 Saving a project

The project can be saved using the File – Save Project menu option, by clicking button at the top of Workspace, or by pressing the Ctrl + S shortcut. For projects that have not yet been saved, the project creation window will appear (see subsection 4.1).

The Artec Studio application uses the principle of incremental data saving, which means that, in case of sequential saving of project data, only newly changed or added data will be saved.
4.3 Opening a project

An existing project can be opened using the File – Open Project menu option, by pressing button at the top of Workspace, or Ctrl + O shortcut.

Note: Project saved in the later version of Artec Studio in SPROJ format, may not be opened in the earlier version in all cases. At the same time, files of Artec Studio versions 8, 9 and 10 are compatible.

By default, projects (scans loading state: loaded, unloaded, key frames only, see subsection 4.7) will be restored to the state of the last saving. If you want to make the loading faster and open the project with all the scans unloaded, use the Open project (unloaded scans) drop-down menu option under the button, the same option from File menu or use Ctrl + Shift + O key combination.

Note: When a project is opened, the application will check for available RAM. If the scan you are trying to open requires more RAM than there is available, it will be processed in as an “unloaded” scan.

4.4 Exporting models and scans

When data is saved for future processing in the Artec Studio application, it is best to save the project as SPROJ or to export into SCAN format. The latter can be open in any version of Artec Studio. However, if you plan to use this data in other applications, scans and individual frames should be saved in other formats.

If you need to:

export one or several scans, select the Export scans command. In this case, all frames are being saved in the designated folders which have names matching corresponding scan names. SCAN format is an exception, it not only stores frame-by-frame scan structure, but produces a single file.

export single surface, it is best to select Export mesh command. If you marked with button several scans, models or frames, Artec Studio suggests merging them.
To export scans:

1. Mark scans that you are going to export with the \( \text{出口} \) button.
2. Select the Export scans... command in the File menu or the corresponding drop-down menu option of the \( \text{出口} \) button in the Workspace panel.
3. Click the \( \text{...} \) button in the window that opens and specify destination folder.
4. Select Scans export format using drop-down list of the same name (figure 4.2).
5. If the selected format supports texture, also specify texture format.
6. Select the Apply transformation checkbox or keep it cleared (for more information, consult subsection 4.4.1).
7. Click OK.

To export mesh:

1. Mark one or several models with \( \text{出口} \) or select frames inside the scan by clicking on them while holding down the \( \text{Ctrl} \) key.
2. Select the Export mesh... command in the File menu or the corresponding drop-down menu option of the \( \text{出口} \) button in the Workspace panel.
3. Click the \( \text{...} \) button in the window that opens.
4. Specify destination folder, enter file name, and select the necessary format from the drop-down list.
5. Click Save.
6. If required, select Textures export format (see subsection 4.4.2).
7. Click OK.

![Figure 4.2: Formats available for both commands and each of them separately](image)

**Note:** Export of models and scans runs in the background, so the application will not be locked and you can continue working with the scans. The progress indicator for the export operation will appear at the bottom of the main application window. To abort the operation, press Cancel in the bottom-right corner.
4.4.1 Understanding applying transformation

There are two options to export surfaces:

1. Store surfaces in the scanner coordinates and add text XF files with coordinates that have been calculated during registration. If it is a suitable option for you, clear the Apply transformations checkbox.

2. Store surfaces already relocated in the positions that have been calculated during registration. In this case, XF files do not carry any relevant data. Select the Apply transformations checkbox if this solution works fine for you.

4.4.2 Storing and exporting color information

There are three ways to transfer color information for 3D surfaces. The most widely employed way is through texture, a separate bitmap file (see subsection 5.8.1). Another option is to save color information in each vertex of a mesh. The third one is to assign small textured fragment for each polygon. The two latter methods do not produce any texture file.

Colors stored in vertex are blended throughout the polygon. So that mesh being exported should not be simplified significantly. Otherwise color blended over large face may fail to render true texture information.

<table>
<thead>
<tr>
<th>Texture as a bitmap</th>
<th>PLY, VRML (*.wrl), OBJ, X, e57</th>
</tr>
</thead>
<tbody>
<tr>
<td>Separate texture to each face stored inside model file</td>
<td>PTX</td>
</tr>
<tr>
<td>Format supporting vertex color</td>
<td>plyVC, XYZRGB</td>
</tr>
</tbody>
</table>

When exporting texture as a bitmap image, you can select one of the following formats: PNG, BMP, JPG. PNG format provides the best quality for file size due to its lossless image compression. JPG is considered the most compact format.

4.4.3 Export to Leios

Export of files to Leios software application is now possible from the menu File (see figure 4.3a) if Leios is already installed on the computer. A user should select a model in the Workspace, open File – Export to Leios and then select millimeters as the length unit for the imported files in Leios.
4.5 Importing models and scans

Importing is another way of loading data into the Artec Studio application besides capturing or opening a project. Scan files created in earlier versions and individual frames can be imported in the following formats: PLY, STL, VRML, OBJ, PTX. To do it, use the File – Import... menu option, the shortcut Ctrl + I or a drop-down menu option of the button. Then select a file for importing. You can also drag and drop a file into the main Artec Studio application window or just double click on it.

Note: Importing runs in the background, so the application will not be locked and you can continue working with the scans already loaded. The progress indicator for the import operation will appear at the bottom of the main application window. To abort the operation, press Cancel in the bottom-right corner.

Frame files will be imported as individual one-frame scans. After importing each scan, for scans, which contain more than one surface, the application performs calculation of the
key frames (see subsection 1.5). Also, when the corresponding setting is enabled (see subsection 7.1.5), the application will check the surfaces for defects. If defects are found, the user will be shown a dialog box with a list of defective surfaces after the import operation is finished. The user will then be able to choose, which surfaces should be corrected (see figure 4.4).

### 4.6 History of project changes

All data changes are stored in the Artec Studio application and can be undone in the future. To do this, use button in the Workspace panel for undoing the operation or for redoing the previously undone operation. You can also use shortcuts Ctrl + Z or Ctrl + Y. Use the drop-down menu buttons or to undo or redo several operations at once.

When a project is saved, 3D data are saved together with the history of changes. The maximum length of history can be set in the settings window under the Performance Tab (see subsection 7.2.3). There is also a Compact memory button for saving the history of changes on a local drive and, thus, freeing RAM, as well as the Clear history of commands button for clearing the history of changes, which also frees RAM and makes the undo operation for the most recent changes unavailable. To clear history, you can also use the Edit – Clear history menu option in the application’s main window or the Ctrl + Alt + H shortcut.

### 4.7 Selective loading of project data

When working with a large dataset, it is often necessary to free up RAM without deleting some of the project data. For this purpose, a selective scan loading mechanism has been implemented in the Artec Studio application. Scans that are currently unused can be unloaded on a disk to free up extra RAM. In case some of the unloaded scans are required for the operation of the algorithms, they will be automatically loaded back. Frames that are currently not loaded into the memory will not show in the 3D View window. Scans or frames completely unloaded from memory are displayed in grey italicized font in the Workspace window (see figure 4.5).

*Note: The project must be saved, so that the scan loading status could be changed.*

To change the status of scan loading, select the scans in the Workspace window (using Ctrl key), click RMB, and select one of the scan loading options in the pop-up (figure 4.5) menu:

<table>
<thead>
<tr>
<th>Menu command</th>
<th>Function</th>
<th>Resulting icon look</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unload scans</td>
<td>Fully unload scans from RAM</td>
<td></td>
</tr>
<tr>
<td>Load key frames only</td>
<td>Leave only key frames in RAM</td>
<td></td>
</tr>
<tr>
<td>Load scans</td>
<td>Fully load scans into RAM</td>
<td></td>
</tr>
<tr>
<td>Load textures</td>
<td>Fully load texture images into RAM</td>
<td></td>
</tr>
<tr>
<td>Unload textures</td>
<td>Fully unload textures from RAM</td>
<td></td>
</tr>
</tbody>
</table>

Algorithms may change loading status of the data in project in the following cases:

- unloaded scans selected for processing by checking icon are to be loaded into RAM;
- much memory is required for algorithm execution – that is why unused scans, frames or textures will be unloaded.
Note: In addition to the 3D data, a large part of RAM can also be tied up by the history of changes. For information on how to control the amount of history and how to unload/clear it, please consult subsection 4.6.

4.8 Autosaving a project

Saving of a project can be initiated both by the user and automatically by the application. In the latter case it is called autosaving. For temporary, i.e. unsaved projects, autosave is not available. Autosave is initiated in the following cases:

- Before running the texturing algorithm (see subsection 5.8).
- Before launching algorithms from the Tools panel when the corresponding setting is selected (see subsection 7.1.2).
- Before and after running global data registration algorithm (subsection 5.3).
- Before entering and after leaving Align tool (subsection 5.2).
- When scanning is over and the Back copy scan data on disc option is selected (see subsection 2.2.13).
- When unloading scans with unsaved changes (see subsection 4.7).
Chapter 5

Data processing

After scanning the object from all the desired angles and creating a sufficient number of scans, you can proceed to building a 3D model. This chapter offers a detailed description of the process. In most examples, a plastic decorative figure of a duck will be used as the test object (figure 5.1).

![Figure 5.1: Target object: a duck](image)

The process of creating the final model includes the following stages:

- Revising and editing the data (subsection 5.1);
- Alignment of scans (subsection 5.2);
- Global data registration (subsection 5.3);
- Fusion of data into a single 3D model (subsection 5.5);
- Final editing of the 3D model (subsection 5.6);
- Texture mapping (Section 5.8).

### 5.1 Revising and editing scans

Sequence of frames obtained at each scanning session is saved into a separate scan. The list of all the scans in a given project is displayed in Workspace of the application (figure 5.2a).

Data in the Workspace are arranged in the following columns:
• **Selection flag** – scans marked with a ☐ in this column, will be displayed in the *3D View* window and will be processed by all algorithms and tools of *Artec Studio* application.

• **Color** – in this column, each scan has a colored square next to it. The filling of the square depends on the number of scan frames loaded into the application. When all the frames are loaded, the square will be fully filled in. When only key frames are loaded, it will be half-filled. When all the scan data is unloaded, it will be unfilled (see subsection 4.7). The scan color can be changed by pressing the corresponding square and selecting the desired color from the palette.

• **ID** – ID number of the scan.

• **Title** – when a scan is created, it will be automatically assigned a name like Scan1, Scan2 etc. based on values of Prefix and Start with fields in the *Scan* panel. To rename the scan, select it by left-clicking on its name. Then either press F2, or right-click on the scan’s name to open the drop-down menu and select the Rename... option. Both operations open a dialogue box where the new name can be entered.

• **Loaded** – number of scan frames loaded into the memory (see subsection 4.7).

• **Total** – total number of frames and the size of a particular scan.

• **Quality** – scan registration quality - which is the maximum value of the registration error for any frame in that scan.

### 5.1.1 Data selection

#### Scan selection

**Note:** In order to view scan in *3D View* or process it with any tool, you should first mark it with ☐ icon.

<table>
<thead>
<tr>
<th>Purpose</th>
<th>Way</th>
<th>Alternative way</th>
</tr>
</thead>
<tbody>
<tr>
<td>Just select scan in <em>Workspace</em></td>
<td>Left-click on the scan name</td>
<td>—</td>
</tr>
<tr>
<td>Enable displaying scan in <em>3D View</em> window and activate it for processing by algorithms</td>
<td>Left-click in the empty area of the leftmost column</td>
<td>Click scan name with Shift + Alt + LMB</td>
</tr>
<tr>
<td>Disable displaying scan in <em>3D View</em> window and deactivate it for processing by algorithms</td>
<td>Left-click on ☐ icon</td>
<td>Click scan name with Shift + Alt + LMB</td>
</tr>
<tr>
<td>Batch selection (deselection) of scans for processing and displaying</td>
<td>Click</td>
<td>Press Ctrl + A (Ctrl + D)</td>
</tr>
<tr>
<td>Select a single scan for processing and deselect others</td>
<td>Click Ctrl + Alt + LMB on the scan name</td>
<td>Click Ctrl + LMB in the empty area of the leftmost column</td>
</tr>
</tbody>
</table>

In addition to the ways covered in the table above, you may use desired commands from the drop-down menu of button. See also the full list of the hotkeys given in Appendix B.
Frame selection

Double-clicking the scan name opens the Surface list panel, revealing all the frames in that scan (figure 5.2b). If the opened scan has only one frame, a panel with frame data (figure 5.3) will be shown instead of a list.

Highlighting specific frames will make them (and only them) appear in the 3D View window. When the Show other selected scans option is checked on the bottom, the selected frames from other scans will also be displayed in the 3D View window. Frames can be selected in the following ways:

- Clicking LMB on the frame name will select it while clearing other selections.
- Clicking LMB while holding the Ctrl key allows selecting several frames at once.
- Clicking LMB while holding the Shift key will select a sequence of frames within the specified range.
- Clicking the icon on the Surface List panel selects all the frames or clears selection.
• Using the dropdown menu of the button you can quickly select all the key frames or all the textured frames.

• Clicking Ctrl + A will select all the frames.

By pressing the or Ctrl + P shortcut you can start a sequential frame demonstration, which can be stopped by pressing or by pressing Ctrl + P again.

5.1.2 Scan revision

As you begin building a 3D model, you should start by pre-processing scans: remove unwanted frames, separate misaligned areas (if any) into separate scans, cut out unwanted and non-rigid objects from the scene.

The following problems may be encountered:

• misalignment of frames in relation to one another (see figure 5.4a) – this may occur due to small size, insufficient number or absence of geometrical features on the object or due to insufficient number of polygons in a frame.

• misaligned parts (see figure 5.4b) – this occurs when the alignment algorithm working in real time incorrectly determined the position of the new frame relative to the previous ones.

• unwanted objects are captured in the frame (see figure 5.4c).

A visual inspection of the frames can be very helpful in determining problematic areas. To perform a visual inspection, select the scan and view all the frames contained in it by holding Arrow Up or Arrow Down key on the keyboard. Misaligned frames can easily be detected by means of this technique.
Removing unwanted frames

You have to remove misaligned frames and frames with insufficient number of polygons from the scans. To delete these frames, select them from the list and press Del.

**Note:** The system will not ask for confirmation of this operation, data will be deleted instantly. You can restore the deleted data by pressing Undo button.

Scan separation

During the fine alignment process, frames within certain scans can be misaligned. Sometimes it is possible to divide the problematic scan into several parts, where each part is registered fairly well. In this case divide the scan into several scans. Moving some of the frames into a new scan requires the following steps:

- Select the frames you want to move in the Surface List panel.
- In the Surface List panel click the RMB and select Move to new scan (figure 5.5).
There is another way to fix alignment errors: you can reset current values of frame transformations and repeat the registration, possibly changing certain settings. To do so, select the desired scan in the Workspace panel, click on it with RMB and select Reset transformations from the drop-down menu. This will reset the computed positions of individual frames within the scan. A dialogue will appear prompting you to confirm the operation. To compute new positions, you have to run the Rough Serial Registration and Fine Serial Registration algorithms (also see 2.2.14 section).

5.1.3 Editing scans

To edit the selected scans, open the Editor tools from the side panel. and icons will appear alongside the existing icons on the icon bar of the 3D View window, corresponding to the Positioning, Transformation, Smooth brush, Eraser, Defeature brush and Texture healing brush tools. The latter is covered in Section 5.9.

Figure 5.6: Editor panel

Moving, Rotating, Scaling (Transformation tool)

Transformation tool is intended to move, rotate or scale objects in the 3D View window.

To access this tool, open the Editor panel and select Transformation tool by either clicking button, or pressing hotkey T. The panel opens, displaying three tabs that correspond to different modes of altering the object position in the global coordinate system. The name of currently active mode is displayed at the bottom of the 3D View window.

- To enter the translation mode, click the Translate tab or press the T. Three input boxes containing the coordinates (in millimeters) of the current local coordinate system center will appear in the Editor panel. Initial position of the local coordinate system is in the center of the global one. To translate the object, perform either of the following:
  - Enter the new values of coordinates of local system into the input boxes of the Editor panel. In order to adjust position only along a specific axis, press the corresponding button X, Y or Z beforehand.
Freely translate the object in the 3D View window by dragging the square control. Or translate the object along a specific axis by dragging only the necessary arrow control near the square control (see figure 5.7a).

**Note:** If it makes orientating the object easier, you can first specify a new position for the center of the local coordinate system by double-clicking in the desired point of the surface in the 3D View window.

![Transformation tool controls](image)

(a) Translate   (b) Rotate   (c) Scale

Figure 5.7: Transformation tool controls

- To enter the rotation mode, click the Rotate tab or press the R key. Three input boxes containing the values of Euler angles will appear in the Editor panel. Initially all values are set equal to zero. To rotate the object, perform either of the following:

  - Enter the new values of angles (in degrees) into the input boxes of the Editor panel. In order to rotate the object only around a specific axis, press the corresponding button X, Y or Z beforehand.
  - Drag one of the three circles (see figure 5.7b).

  **Note:** Rotation around axes X and Y changes the values of all three Euler angles.

  **Note:** If it makes orientating the object easier, you can first specify a new position for the center of the local coordinate system by double-clicking in the desired point of the surface in the 3D View window.

- To enter the scaling mode, click the Scale tab or press the S key. The single input box with the current scale (1.000) value will appear in the Editor panel. To scale the object:

  - Enter the new scale value in this input box.
  - Drag the center of the control (figure 5.7c) or either of its round ends in the 3D View window.

After altering the object with any of the methods described above, confirm or cancel your changes by clicking Apply or Cancel, accordingly. Each time you press the Apply button, the object position is being saved in the project history. Thus, the object position can be reverted to the initial one using the button Undo in the Workspace after you exit the Editor panel.
Placing onto coordinate plane (Positioning tool)

You may need the model placed onto one of the coordinate planes for some reasons (i.e. aesthetic grounds, preparing model for measurements, screenshot capturing, exporting, etc.). Instead of adjusting the model position by Rotate and Translate modes in Transformation tool you can use special Positioning tool. To run it perform the steps below:

1. Open the Editor panel on the side toolbar and press either Positioning tool or button in the upper part of 3D View window or hotkey \( P \).

2. Choose the coordinate plane which you want the model to be placed onto by activating one of the following options: \( XOY \), or \( YOZ \), or \( ZOX \). Note that you may skip this step and return to it after step 3.

3. Specify with LMB at least three points on the surface, the plane automatically passes through their center of mass (figure 5.8). At that the following conditions are met:

   (a) Specifying every additional point, you get the plane rebuilt. Any moment you can press Clear points and redefine points.

   **Note:** As it is known three points are sufficient for defining the plane. But when dealing with nonplanar surfaces, it may be uneasy task to do with three points. In that case more points you specify, more precisely a plane will fit.
(b) Not only plane passes through the center of mass of point set, but coordinate origin is shifted there.

(c) This position of coordinate origin is not fixed and can be corrected, as described in step 5.

4. You may also invert the direction of coordinate axis by pressing the corresponding button Invert Z for XOY plane, X for YOZ plane, and Y for ZOX plane.

5. You may additionally adjust the model’s position regarding the coordinate origin. Hold Shift key and move the mouse with the following keys pressed:

(a) Shift + LMB to rotate the model around the axis that is currently normal to the plane

(b) Shift + RMB to move the model along the plane in a fixed direction

(c) Shift + LMB + RMB to move freely along the plane

6. Press Apply to get the model fixed onto specified plane or Cancel if you do not satisfied with its position.

**Smooth brush**

The Smooth brush is a tool that can be used selectively in specific areas without touching the areas, which do not require alteration (read about automatic smoothing in the subsection 5.6.5).

To use the Smooth Brush tool, select only one surface, open the Editor panel and click the icon or press hotkey S. When the Ctrl key is pressed, an orange spot will appear around the cursor in the 3D View window. You can change its size either by using the Ctrl + [ and Ctrl + ] shortcuts, or Scroll wheel, or typing its size in millimeters in the Brush size field, or adjusting the slider bar in the Smooth Brush panel. Smooth strength can also be set by typing its value in the Smooth strength field, or by adjusting the slider bar. Pressing and holding the LMB in this mode, will smooth the affected areas (see figure 5.9c). Once done, click Apply or Cancel buttons.

![Smooth brush panel](image1.png)

(a) Smooth brush panel

![Before smoothing](image2.png)

(b) before smoothing

![Smoothing process](image3.png)

(c) smoothing process

Figure 5.9: Smoothing out a poorly captured area
Erasing parts of scans

Nearly always, unwanted elements are captured during scanning, e.g. operator’s hands, walls, surfaces that the object is located on, and other irrelevant objects. This unwanted data can hinder post-processing. In order to avoid this, it is recommended to get rid of them before processing. There are several options designed for a quick and easy removal of unwanted elements from the scene (see figure 5.11).

- **2D selection** is designed for deleting or areas or objects of medium size.
- **3D selection** is useful for accurate cleaning of small areas of objects.
- **Rectangular selection** allows to select vast rectangular regions.
- **Lasso selection** allows to create a selection by freely drawing it with the cursor.
- **Cutoff plane selection** is a special mode for removing flat surfaces (table, floor or base) that the object is located on. This mode uses a cutting plane that divides the scan into two parts: the first one is to be left and the second one is to be erased (see figure 5.12b).

![Figure 5.10: Eraser panel](image)

The general procedure of erasing is as follows:

1. In the Workspace panel select scan that needs editing and open the Editor panel by clicking its icon on the side toolbar. Editor icons will appear alongside the existing ones on the icon bar of the 3D View window.

2. If the scan is rendered with no texture, make sure it has a color different from red or any shade of red. Assigning non-red colors to scan will help you easily identify polygons selected for erasing. If necessary, change its color by clicking the colored square (■) near its name.

3. Open Eraser tool by clicking on 📡 or by pressing hotkey E.
4. Select the desired erasing mode (consult the list above).

   **Note:** If you are going to use Cutoff plane selection, make sure the Select through toggle is in position in 3D View window.

5. Mark the elements to be erased. Press and hold down Ctrl key and do either of following depending on the active mode.

   **2D/3D selection:** Adjust tool size (see table) and paint over the area of interest with LMB.
   **Rectangular selection:** Drag the cursor to select a rectangular region.
   **Lasso selection:** Drag the cursor to freely outline an irregular region.
   **Cutoff plane selection:** Adjust tool size (see the table) and paint over the flat area. Once you have released the mouse button, a plane appears (figure 5.12). If necessary, adjust the level of the plane by using Scroll wheel while holding down Ctrl+Shift shortcut.
<table>
<thead>
<tr>
<th>Purpose</th>
<th>Way</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deselect region</td>
<td>Reselect this region while holding down <strong>Ctrl+ALT</strong></td>
</tr>
<tr>
<td>Undo operation</td>
<td>Press <strong>Ctrl+Z</strong> or click <img src="image" alt="undo" /></td>
</tr>
<tr>
<td>Adjust size of the tool</td>
<td>Use <code>[</code> and <code>]</code> keys or <strong>Scroll wheel</strong> while holding down <strong>Ctrl</strong></td>
</tr>
<tr>
<td>Protect backface from erasing</td>
<td>Use <strong>Select through</strong> toggle: <img src="image" alt="protected" /> — backface is protected (figure 5.11f), mandatory for <strong>Cutoff plane selection</strong> <img src="image" alt="affected" /> — backface is affected (figure 5.11e)</td>
</tr>
<tr>
<td>Reach hardly accessible regions</td>
<td>Select (in the same way as for erasing) and click <strong>Hide</strong> to hide obstructing polygons</td>
</tr>
</tbody>
</table>

6. Click **Erase** button to erase highlighted in red area or apply cutting plane.

![Figure 5.12: Cutoff plane selection mode](image)

**Hiding polygons in Eraser tool**

If some polygons obstruct the region that you want to erase, you can hide them. Before step No. 5 in the list in the **Erasing parts of scan** paragraph, do the following:

1. Make sure the **Select through** toggle is in ![select](image) position in 3D View window.

2. Mark the obstructive region using the technique covered in step No. 5.
3. Click *Hide* to get an access to the obstructed region.

4. Now you can mark the region that needs to be erased.

**Defeature brush**

Erasing some geometrical imperfections often demands further processing of holes formed. *Defeature brush* combines functions of *Eraser* and *Hole filling* tools and may significantly boost your productivity. To use it follow the steps:

![Defeature brush panel](image)

**Figure 5.13: Defeature brush panel**

1. Select the surface in *Workspace* panel. Only one model or one frame of scan are allowed to be chosen.

2. Open the *Editor* panel on the side toolbar and press either *Defeature Brush* or button in the upper part of *3D View* window or hotkey D.

3. In the *Editor* panel choose selection type: *2D selection* or *3D selection*. Operational principle is the same as in *Eraser* tool, i.e. in 2D mode all the surfaces through the model are affected (if toggle is enabled), while in 3D the brush works over the visible surface.

   **Note:** Results obtained in 2D mode with toggle disabled may be approximately the same as in 3D mode for most of the surfaces.
4. Press **Ctrl** to activate the tool. Depending on the selection type, a red circle or an orange spot will appear in 3D View window.

5. Still holding **Ctrl**, adjust spot size (figure 5.14d) or circle diameter (figure 5.14c) with **Scroll wheel** or [ ] buttons. Their size should match the size of feature being removed.

6. Still holding **Ctrl**, press and hold **LMB** and paint over the area to be modified. A red stroke will appear on it. As you release the **LMB**, the feature will be deleted, the hole will be closed up, and the surface will be smoothed.

7. Repeat, if necessary, steps 3 – 6.

8. Press **Apply** button, and all changes will be saved.

**Note:** If you are editing a textured model, do not forget to turn on the **Polygons without texture** option in View menu (see subsection 3.4.5) to display the processed surfaces. Note, that texture itself will disappear. But you can restore it with texture mapping (see subsection 5.8.1).
5.2 Scan alignment

Immediately after scanning, the Artec Studio application may not contain enough information about the relative position of multiple scans. To combine all scans into a single model, the data must be converted into a single coordinate system, i.e., registration must be performed. The first stage of performing this task is the semi-automatic alignment of scans using the Align tool.

How to select scans and run alignment

In the Workspace panel mark with the flag all the scans you intend to work with. Click the Align button in the side panel. Marked scans listed in the same order as in the Workspace panel appear in the left panel. During the Align tool operation, the selected scans are divided into two sets: set of aligned (registered) scans and non-aligned scans. The first set at the beginning contains only one scan (the first one in the list) which is highlighted in blue color, and its name is shown in bold and marked by the same color icon.

Note: In order to be able to see scans highlighted in the colors assigned, select any option except (Texture in the View – Color menu. See subsection 3.4.2

The operator’s task is to align all scans to the already registered ones and “assemble a model”. In general, the procedure includes the following steps:

1. Click the required tab in the Align panel.
2. Select one scan from the unregistered group in the Align panel. The name of unregistered scan is displayed in a regular typeface. When selected, unregistered scan is marked by the green icon. Several scans can be selected by holding the Ctrl.
3. If necessary, specify point pairs, or sets onto the scans and click the desired alignment command button. The command affects all scans, marked by the round color icon in the Align.

Since each mode has variations in detail, see detailed information in the corresponding subsections. Note that you can use either one or a series of modes (see The Comparison table in the Appendix D): drag alignment, rigid alignment with and without points specifying, automatic rigid alignment and alignment with surface deformations.

How to change scan status

If several scans have been already aligned, they should be moved in the registered set. Select them in the Align panel by using the LMB, then click the RMB on the name of any scan, and select the Mark as registered option from the drop-down menu or just double-click it in the list. From now on, the registered scans are treated as one and cannot be moved independently of each other. In order to change the status of a single scan, you can also double-click the scan name in the list.

If some scan was marked as aligned by mistake, remove it from the registered group by selecting the Unmark as registered item from the drop-down menu or just double-click it.
Displaying scans in 3D View

Scans selected in the Align panel are displayed in the 3D View window. Keys 1, 2 and 3 switch between models shown in the 3D View window:

1 – shows only the blue ● models (aligned scans);
2 – shows only green ● models (scans currently under alignment);
3 – shows both sets of models.

Navigation in align mode is similar to navigation in the 3D View window:

- Rotate – hold LMB + move mouse;
- Zoom in/out – use the Scroll wheel or hold RMB + move mouse;
- Move model – move mouse while simultaneously holding LMB and RMB or the middle button.

5.2.1 Drag alignment

Drag alignment is always available, irrespectively of which tab of the Align panel is active. This alignment mode allows to align scans by manual dragging them in 3D View window. Due to low accuracy of such dragging, this mode can (optionally) be used for preliminary alignment before running more accurate modes.

![Dragging](image1)

![Alignment result](image2)

Figure 5.15: “Drag” alignment of models

1. Select scan for alignment, considering the recommendation stated in the beginning of the section Section 5.2. It is allowed to select multiple scans, but note that these scans will be aligned with registered scans as a single unit.

2. Holding the Shift key and one of the mouse buttons, move and rotate scan being aligned (a green one ●) relative to the registered scan (a blue one ●) to close proximity. The list of movements allowed and corresponding buttons is presented in the beginning of the Section 5.2.
3. To confirm the alignment, release mouse buttons, the \textit{Shift} key and click the \textit{Apply} button. It is important to note, that scans being registered will not be added to the registered set (see figure 5.15b). It can be manually made by considering the recommendations in the beginning of the 5.2.

4. If you have several scans to align, repeat these steps for each of them sequentially.

\subsection*{5.2.2 Automatic rigid alignment}

Rigid alignment is a universal mode which is suitable for alignment most of the scans. The easiest way to align scans is through the use of auto-alignment. The advantages of the mode include the ability to align several scans at once and to skip point specifying, while disadvantages are as follows: requirements to the texture quality and to the size of an overlapping area between scans being aligned.

To run the auto-alignment follow these steps:

1. Make sure that \textit{Rigid} tab is selected (see figure 5.17a).
2. Select all the scans by using the \textit{Ctrl} key, as mentioned in the beginning of the Section 5.2.
3. Click \textit{I'm feeling lucky! (auto alignment)}.

\textbf{Note:} Auto-alignment may end in failure if the scans have poor texture or small overlapping area. You may also get not each scan registered, two sets of scans (\textbullet{} and \textbullet{}) may stay in the list. In that case try to align them manually as described in the subsection 5.2.5.

\subsection*{5.2.3 Manual rigid alignment without points specifying}

Rigid alignment can be carried out with and without points specifying. If scans is in the state of close proximity (e.g. after “drag” alignment) or if they have large overlapping area or rich texture, you can skip points specifying when aligning the scans.

Perform the following steps:

1. Make sure that \textit{Rigid} tab is selected (see figure 5.17a).
2. Select scan to be aligned, as mentioned in the beginning of the Section 5.2.
3. Click the \textit{Align meshes} button. The alignment result is expected to be as pictured in the \textbf{figure 5.17c}. If you are not satisfied with this result, click the \textbf{ and follow the recommendations given in the subsection 5.2.5.}
4. Select another scan from the list of unregistered scans and repeat the procedure above.
5. Click \textit{Apply} to confirm your alignment results or \textit{Cancel} to reject them.
Texture alignment

If the object was scanned with texture, the texture alignment feature may be used to ease the alignment of scans. Texture alignment uses features from texture images of scanned objects and greatly decreases the possibility of scans not to be aligned incorrectly. It also helps to align objects with poor geometry, like round or flat objects with no corners or geometrical features. However, if an object has rich and non repetitive geometry, it is recommended to disable texture alignment to decrease time needed for alignment algorithm. Please also keep in mind that texture alignment will not be useful if texture of the object is monochrome.

To enable texture alignment, select the Enable texture align checkbox at the bottom of the Align panel just before the step No. 3 in procedure above.

![Figure 5.16: Checkbox for texture alignment](image)

**Note:** Texture alignment is a resource-consuming algorithm that slows down the alignment process. It is recommended to use the option only in cases when geometry features of the object are insufficient.

5.2.4 Understanding specifying points and editing their position

Before considering the alignment with points, it is wise to stop at highlighting matter of point pairs specifying. Alignment algorithm use point pairs, or point sets in the “Constrained alignment” (subsection 5.2.7), for detecting areas on the scans to be brought close together.

For point alignment, mark several pairs of corresponding points on the scans that have been aligned and scans being aligned. In the "Constrained" mode point sets can be specified even within one or within several scans being aligned, while in the rest of modes it is advisable to confine the number of scans to one. Make sure that points for a given pair correspond to the same point on the surface of a real object, but note that high matching accuracy is not needed, since pairs are used only for rough approximation before precise registration.

When specifying points in the “Rigid” and “Non-rigid” modes, pairs are automatically created. Having specified one pair, you can immediately create the next one. In the "Constrained" mode you have to confirm set creation by pressing the Space button or by clicking the New set button on the left panel, due to multiple points forming the set (see figure 5.17b and figure 5.20b).

You can toggle between the point pairs (sets) by pressing the Space and Backspace keys or by clicking the RMB in the 3D View window and selecting the relevant options from the menu. You can relocate points of the pair (set). Hover with mouse cursor over the point until the pair (set) will have been highlighted with white color, then drag the point to the proper position with LMB or select the pair (set) and specify new position for the point by using the LMB. To confirm actions and deselect pair (set), press Space. You can also remove either a pair (set) or one of its point. Click with RMB on the point and choose the required command from the menu. You can alternatively use the Del button for removing the selected pair (set).
5.2.5 Manual rigid alignment with points specifying

It is advisable to use this mode when scans are located at a significant distance from each other.

Follow the steps:

1. Make sure that Rigid tab is selected (see figure 5.17a).
2. Select scan to be aligned, as mentioned in the beginning of the Section 5.2.
3. Specify several point pairs (figure 5.17b), considering the recommendations given in the subsection 5.2.4.
4. Press the Align markers. This mode takes into account only coordinates of specified points and tries to reduce the distance between the markers from each pair.
5. Carry out the steps 3-5 of the procedure given in the subsection 5.2.3.

5.2.6 Non-rigid alignment

While rigid alignment is only capable of performing such transformations as translation and rotation, the non-rigid algorithm can deform 3D data. This algorithm is intended to process so-called non-rigid objects, i.e. objects that have changed their shape during scanning (e.g. models of humans (figure 5.18b) or animals). Keep in mind that the surface obtained as a result of deformation may differ from the surface of the actual object.

Note: Non-rigid alignment works on models only. Thus, before you run it, prepare models by fusing source scans. It is also necessary to align models in the rigid mode beforehand (see subsection 5.2.3, subsection 5.2.2 or subsection 5.2.5).

To run the non-rigid alignment, follow these steps:

1. Make sure that Non-rigid tab is selected (see figure 5.18a).
2. Select model(s) to be aligned, as mentioned in the beginning of the Section 5.2.

3. If the models significantly differ from each other, it is advisable to specify some point pairs, considering the recommendations given in the subsection 5.2.4.

4. If necessary, adjust the deformation degree with Flexibility slider. The greater the Flexibility values, the more Flexible deformation, and the longer the computation lasts.

   **Warning!** Avoid extreme values of the Flexibility slider! Adjusting extremely great values may result in large deformations of the surfaces, and slow down the processing. While the extremely low values hardly deform surfaces and produce results that are far away from what you expect from a non-rigid alignment.

5. Click the Align... button. The algorithm will align models deforming their surfaces (figure 5.18c). If you are not satisfied with the alignment results, press the and specify additional point pairs or reconsider location of the current pairs.

6. Select another model from the unregistered set and repeat the steps above.

7. Click Apply to confirm your alignment results or Cancel to reject them.
5.2.7 Constrained alignment

Constrained alignment allows to align not only scan to scan, but surface to surface within one scan (see comparison of the modes in the Appendix D). In comparison with other modes this one supports defining multi-point sets, i.e. you can link up more than two points. This mode is useful when aligning scans obtained during circular movements of the 3D scanner in case the fine registration with enabled loop_closure option failed to align them. To run the constrained alignment, perform the following steps:

1. Make sure that Constrained tab is selected (see figure 5.20a).

2. Select the scan (scans) to be aligned, as mentioned in the beginning of the Section 5.2. This mode allows to work even with one registered (●) scan.
3. Specify one or several point sets on the scan surface (figure 5.20b), considering the recommendations given in the subsection 5.2.4.

4. Click the Align... button to run alignment with constraints (results are shown in figure 5.20c). If you are not satisfied with the alignment results, press the ⏯️ and specify additional point sets or reconsider location of the current sets. To repeat the undone operation, click ⬃️ (Redo).

5. Click Apply to confirm your alignment results or Cancel to reject them.

5.3 Global registration

Once alignment of all scans is complete, proceed to the next stage – global registration. The global registration algorithm converts all one-frame surfaces into a single coordinate system using information on the mutual position of each pair of surfaces. To do it, a set of special geometry points is selected on each of the frames followed by a search for pair matches between the points on different frames. For the algorithm to perform correctly, initial approximation is required which is performed in the process of using the Align tool.

Note: Global registration is a resource-intensive operation. Processing of large data sets may take a long time to compute and require a large amount of RAM.

To launch the algorithm, select all aligned scans in the Workspace panel. Open the Tools panel. Locate the Global Registration section and click the Apply button.

5.3.1 Global registration parameters

- registration_algorithm – the type of algorithm to be used for registration of scans. If object has rich texture and poor geometry, consider selecting Texture_and_Geometry option. For objects with rich geometry it is possible to set Geometry mode in order to increase registration speed.

- minimal_distance – the minimum distance between adjoining feature points on the object in millimeters.

- iterations – the number of iterations of global optimization algorithm \(^1\).

- local_align_thr – the threshold of allowable misalignment of key frames, in fact, the distance between surfaces being registered. If you scanned with Kinect v2 from a long distance (subsection 2.2.5), you must change the default value to 5.

5.3.2 Possible global registration errors

- After the Global Registration algorithm has finished, the frames are in disarray (see figure 5.21a) or the position of frames has not changed. This is due to the fact that the application is configured for a different scanner type than the one that was used to capture data. Change the device type in settings (see subsection 7.3.1).

\(^1\)Optimization is a part of the actual global registration algorithm
The algorithm has completed successfully, but there is a gap between two or more scans (see figure 5.21b) – select just these scans in the Workspace and run the global registration algorithm for them. If the scans have drawn closer to each other but have not aligned after algorithm completion, increase the number of iterations and rerun the algorithm. Repeat it until full alignment is reached. Then run global registration for all data once again. If there are several problematic scans and you are unable to align them, try aligning just two of them. Then gradually increase the number of scans until all scans become aligned.

5.4 Outlier removal

During the scanning, so called outliers may appear on the scene. Outliers are small surfaces not connected to the main surfaces. These small surfaces are subject to removal, because they may spoil the model or produce unwanted fragments. There are two ways to do it: erase them before fusion (preventive approach) and after fusion (so called furthering approach, see subsection 5.6.2). Preventive approach is advisable, because it decreases the possibility to spoil fusion with attached noisy features.

This approach is based on the statistical algorithm which calculates for every surface point the mean distances from it to a certain number of their neighboring points and their standard deviation. Then all points whose mean distances are outside an interval defined by the global distances mean for all points and standard deviation are considered as outliers and removed from the scene.

**Note:** For scans obtained with Spider, outliers removal is automatically performed in the Sharp fusion mode. Run Outliers removal algorithm only if you are planning to use any other fusion mode.

For better results, before starting algorithm, it is recommended to run global registration. If you have not run it and have started Outlier removal, a dialog box appears prompting you to run global registration.

In most of the cases none of the parameters accessed through button needs editing. But if necessary, parameters’ values can be adjusted:

- *std_dev_mul_threshold* – is a standard deviation multiplier. The values of this parameter should be chosen according to the following recommendations:
  - **2** – for quite noisy surfaces;
3 – for less noisy surfaces.

- *resolution* – should be set equal to the *resolution* of Fusion expected to be run later.

Press **Apply** to run **Outlier removal**.

## 5.5 Fusion

Fusion is a process of creation a polygonal 3D model. It can be described as melting and solidifying the frames obtained and processed. This is the most interesting part of the processing because polygonal 3D model is what exactly people wait from 3D scanning. To this end, you can use one of the following algorithms having self-explanatory names (see also the summary given in the table 5.2):

- **Fast fusion** produces quick results.
- **Smooth fusion** is good for human body scanning due to its ability to compensate slight movements of the person being scanned.
- **Sharp fusion** perfectly reconstructs fine features and is suited both for industrial objects and human bodies. It is the only mode that unveils all capabilities of **Spider** scanner.

![Figure 5.22: Outlier removal: before and after](image)

To obtain a model:
Figure 5.24: Models of shoe sole obtained through various algorithms (captured by Spider)

1. Make sure the scans you are going to fuse have passed Global registration.
2. Select with Φ button scan or scans in the Workspace panel.
3. Enter the Tools panel.
4. Select the necessary mode, optionally specify values in the parameters.
5. Click Apply.
6. Once algorithm completes calculations, the model appears in the 3D View window and in the Workspace panel, its name matching the algorithm name.

The following parameters are used in the fusion algorithms:

- **resolution** (millimeters) is the step of the grid which is used to reconstruct a polygonal model. In other words this parameter defines the minimal space unit where the polygon of the model will be build in. The lower resolution values, the sharper the shape. When specifying values, you should take into the consideration default values and lower limits given in the table 5.2.

- **radius** (only for Fast fusion) (multiplier, integer) is a factor which defines surrounding space that algorithm takes into consideration when adding each new minimal space unit. Note that the size of the space unit remains unchanged and equals to the resolution value, while the actual search radius is the product of resolution by radius.

- **Fill_holes** (not available for Fast fusion) settles the algorithm to fill holes in the mesh being reconstructed. The ways the holes will be filled in are as follows:
  - By_radius – all holes having radius no greater than the specified in the max_hole_radius textbox value (millimeters) will be filled in;
  - Watertight automatically fills in all holes in the mesh;
Table 5.2: Comparison of fusion modes

<table>
<thead>
<tr>
<th></th>
<th><strong>Fast Fusion</strong></th>
<th><strong>Smooth Fusion</strong></th>
<th><strong>Sharp Fusion</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Usage</strong></td>
<td>Fast results for large datasets, for measurements</td>
<td>Large, noisy datasets with patchy missing regions, scans of stirring objects</td>
<td>Scans from Spider, any scans with regions with fine details and sharp edges</td>
</tr>
<tr>
<td><strong>EVA</strong></td>
<td></td>
<td>resolution no less than 0.4</td>
<td></td>
</tr>
<tr>
<td><strong>Spider</strong></td>
<td></td>
<td>resolution no less than 0.1</td>
<td></td>
</tr>
<tr>
<td><strong>L</strong></td>
<td>resolution no less than 0.5</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Fill_holes option</strong></td>
<td>N/A</td>
<td>Available</td>
<td></td>
</tr>
<tr>
<td><strong>Features</strong></td>
<td>Relatively noisy resulting surfaces. Mode has an additional parameter ( \textit{radius} ).</td>
<td>Smoother results. Mode can compensate slight movements, but it is not recommended for accurate measurements. It is also relatively slow.</td>
<td>Higher level of detail. Faster than Smooth Fusion. But it can intensify the existing noise.</td>
</tr>
</tbody>
</table>

- Manually option prompt you to fill in holes manually in the automatically open Edges panel.
- remove_targets (not available for Fast fusion) – the option (can assume either \( \text{On} \) or \( \text{Off} \) value) allows to erase small embossings from the surface, where targets were stuck on (see subsection 2.2.10).

### 5.5.1 Possible fusion algorithm errors

Sometimes various defects appear on the resulting 3D model after fusion, some of them can be corrected by creating additional scans, while others can be corrected by using model processing tools described in the next section.

![Figure 5.25: Insufficient data](image)

(a) Surface noise caused by insufficient data (b) Improved model after adding one more scan

Errors which can be corrected by capturing additional scans include low-amplitude noise on the surface (see figure 5.25a). Normally this indicates that the affected area has a small number of frames. The number of frames needed to eliminate this noise depends on the reflective properties.
of the object’s surface. To correct the error, one more scan is necessary to cover the noisy area (see figure 5.25b).

Sometimes the reason for the noise is insufficient number of scanning angles. Areas captured at a larger angle turn out to have more noise than areas captured at the direct angle (i.e. 90 degrees). This can be corrected by scanning the area again using the required angle.

When scanning conditions or the object’s features are such that no additional data can be captured, the errors can be corrected using tools Edges (subsection 5.6.3) or Smoothing (subsection 5.6.5). If such errors are frequent, reduce the speed at which the scanner is moving around the object while scanning, or increase the capture rate (see subsection 2.1.3).

5.6 Model editing

The resulting fusion model may contain surface defects due to scanning or registration errors. A number of tools exist in the Artec Studio application for correcting such errors:

- the Repair tool is used for correcting the model’s triangulation errors.
- the Small Objects Filter is used for filtering and deleting small objects near the surface of the model.
- the Edges tool is used for filling holes and smoothing out the model’s edges semi-automatically.
- the Hole Filling algorithm is used for filling the model’s holes automatically.
- the Smoothing algorithm is used for filtering low-amplitude noise over the whole model.
- the Smooth brush tool is used for smoothing surface areas with the most noise manually.
- the Mesh Simplification algorithm is used to reduce the number of polygons within a model while minimizing the loss of accuracy.
- the Remesh algorithm is used to create isotropic mesh while keeping the processed mesh as close to the original as possible.

Each of these algorithms processes all the scans selected in Workspace panel and replaces the original data with the results. If the algorithm has not been successful, the original data can be restored by pressing Undo button in Workspace Panel.

5.6.1 Correcting triangulation errors

After the operation of some algorithms, the resulting model may contain triangulation errors. They include:

- Unattached vertices - points which are not vertices of any of the triangles.
- Vertices with identical coordinates.
- Faces containing invalid vertices – triangles pointing to non-existent vertices.
- Singular faces – triangles with at least two of the three vertices coincide.
- Faces with equal signature – faces with a fully coinciding sets of vertices.
• **Edges incident to three or more faces** – edges adjacent to the three or more faces.

• **Faces with wrong orientation** – faces with normals directed opposite of the normals of the adjoining faces.

To correct these errors, select a model in *Workspace*, and press *Repair* on a side panel. If no triangulation errors are detected by the algorithm, the application will notify the user that no defects have been found. Otherwise, the *Repair* panel will open, displaying the above mentioned list of defects to be corrected. Next to the names of the defects, a column will appear stating the number of defects of a certain type found in the model. You can select all defects by pressing *View all*. This will display all the defective vertices and triangles on the model using colored points. You can disable displaying defects of any type by unmarking the ☐ icon next to their names, or disable displaying all defects by pressing *View None*. To correct the defects, press *Repair All*. Press *Apply* button to accept the changes.

### 5.6.2 Filter for small objects

If you had not erased outliers before fusion (see subsection 5.4), they might be solidified and preserved on the scene as small distant pieces. Outliers on the fusion can be removed effectively using a filtering algorithm.

To do so, select only the model you are editing in the *Workspace* and open the *Tools* panel. Click the *Apply* button next to *Small Objects Filter* to run the filtration algorithm (see figure 5.26). The algorithm settings window will be open after pressing the ☐ button. The following algorithm parameters are available:

- **mode** – selecting the *Leave biggest objects* option from the drop-down menu, will erase all objects except the one consisting of the most polygons; selecting the *Filter by threshold* option will erase all scene objects with the number of polygons less than specified in the *threshold* parameter.

- **threshold** – threshold parameter, number of polygons, that is used in case the filter mode is set to *Filter by threshold*.

![Figure 5.26: Outliers filtering](image-url)
5.6.3 Hole filling and edge smoothing

Sometimes the complex shape of an object or scanning conditions do not allow for proper capturing of all its parts. As a result, the fused 3D model will have holes. In those instances, the hole filling tool can be used for interpolating the surface.

To start analyzing and correcting the model, select it and press the Edges button on the side panel. This panel has two tabs: Edges and Holes, each of them containing a list of holes detected on the surface which are sorted by their perimeter length. When a hole is selected, the corresponding edge will be highlighted in the 3D View window. If the Move camera to selection option is checked, the model will automatically turn to display the selected edge in the 3D View window. By default, the camera moves smoothly from one edge to another when switching between edges. If the model itself is large, this movement may take too long. To expedite the switching, clear the Animate Camera checkbox.

The user must select edges for correction by checking the checkbox next to them. Such edges will be highlighted in red in the 3D View window (figure 5.27a). The Select All and Deselect All buttons on the panel allow making a selection / clearing all selections. You can also select edges right on the model. To do this, rotate the model to make the edge visible in the 3D View window. Then press the LMB to select it.

![Figure 5.27: Correcting holes](image)

Under the Holes Tab, you can run automatic smoothing of the holes after their filling by checking the Smooth holes after filling option (see also subsection 5.6.5). Under the Edges Tab, use the Strength slider to control the intensity of edge smoothing. Also, you can use this tab to smooth out a part of the edge instead of the whole one. To do this, rotate the model to make the edge visible and mark it in the list as “processing required”. Then hold the LMB and move the mouse over the edge to drag apart the ends of the profile to the desired position (figure 5.28).

After all the edges to be fixed have been selected, click Fill holes or Smooth edges buttons. The model will be fixed. If the result is satisfactory, press Apply to confirm the operation. Otherwise, you can always use the button to cancel changes. If you try to exit the Edges mode without accepting changes, the program will ask you to confirm the action.

5.6.4 Automatic hole filling

For quick, automatic hole filling, use the Hole Filling algorithm in the Tools panel. The algorithm uses the same edges as the Edges tool, processing only holes with the parameters corresponding
5.6.5 Smoothing

The smoothing algorithm is used for smoothing noisy areas of the 3D model. Two tools exist in the Artec Studio application: automatic smoothing of the whole model and manual smoothing of specific areas with a brush (see subsection 5.1.3).

To run the automatic smoothing, open the Tools panel and select the Smoothing operation. There is only one parameter to set:

- **steps** – specifies the number of smoothing algorithm iterations to be performed.

- **max_hole_len** – maximum length of the hole perimeter in millimeters. Holes with parameters not exceeding the specified limit will be processed.
5.6.6 Mesh simplification

The mesh produced after fusion may not be optimal for some applications because it will contain a large number of polygons. This complexity will increase the amount of memory the model occupies, hindering further processing. To optimize the model size and retain accuracy, use the mesh-simplification algorithm.

![Figure 5.30: Original mesh shown on the left, optimized mesh on the right.](image)

Select the model and open the Tools panel. Two algorithms are available.

**Conventional algorithm**

Open the drop-down algorithm settings by clicking the button next to *Mesh Simplification*. Select the appropriate processing method (determined by the *stop_condition* value):

- **Accuracy** – optimize model to a predetermined accuracy:
  - The error parameter defines the optimized model’s maximum allowable deviation (in millimeters) from the original one. When the algorithm reaches this value, the optimization stops.

- **Remesh** – perform simple mesh optimization, removing triangles with edges whose lengths are less than the *remesh_edge_thr* value (in millimeters).

- **Triangle quantity** – simplify the model by targeting the number of triangles specified in the *tri_num* parameter. The algorithm minimizes the resulting model’s deviation from the original model, but the final deviation value is unknown until processing concludes. Use this method when you know how many triangles the resulting model should include.

  **Note:** To determine the number of triangles, double-click the appropriate model from the list in the Workspace panel (see figure 5.3).

- **UV_Triangle_quantity** – similar to the Triangle quantity algorithm but intended for meshes with textures mapped by the Atlas method (see subsection 5.8.1). This approach not only simplifies the polygon grid, reducing the number of triangles, but it preserves texture.

- **UV_Vertex_quantity** – simplify a textured model by targeting the number of vertices specified in the *vrt_num* parameter.

The three first algorithms in the list above have additional parameters:
- *keep_boundary* – maintain the model boundary. Mesh simplification on the scan edges may affect their geometry. Thus, if the shape of the boundaries is more important than the optimized mesh, select the *On* value. Otherwise, select *Off*, and the algorithm will simplify the boundary mesh.

![boundary_images](image.png)

(a) keep_boundary enabled  
(b) keep_boundary disabled  

*Figure 5.31: Boundary appearance*

- *max_neighb_normals_angle* – the angle between two neighboring faces normals. You can specify an angle (120° default) to prevent *Artec Studio* from creating degenerate triangles. If the angle measure in some region exceeds the specified value, the algorithm will not simplify the mesh in this region. Note that the default value is appropriate in most circumstances.

After adjusting the algorithm settings, press *Apply* to start processing.

**Note:** *Mesh simplification may take a long time when there is a considerable difference between the original and the optimized models’ parameters* (for example, if the deviation value is high in the Accuracy mode or if the required number of polygons in the Triangle quantity mode is much smaller than the amount of polygons in the original model). *For very large 3D models the operation will need a lot of memory resources and may fail due to insufficient RAM. Free the memory by closing unused applications and by optimizing memory usage in *Artec Studio* considering recommendations given in 7.2.2, 7.2.3 and in 4.7.*

### Fast mesh simplification

*Fast Mesh simplification* algorithm works faster than conventional one. To start it, perform these steps:

1. Open the drop-down algorithm settings by clicking ☐ button next to the *Fast Mesh Simplification* name.

2. Specify in the *tri_num* textbox the desired number of triangles in the resulting model. You can find out number of triangles in the actual model by double-clicking it in the *Workspace*.

3. Set *force_constraints* option:
   - If this option is set to *Off*, value specified in the *tri_num* textbox remains constant
   - If this option is set to *On*, value specified in the *tri_num* textbox can be automatically updated for the purpose of a better quality of the resulting surface.

4. Click *Apply* to run the algorithm.
5.7 Automatic Processing

Automatic Processing is a special mode of Tools panel intended to save time and simplify post processing. It allows to run all post-processing algorithms from Tools panel (Rough, Fine and Global Registration, Fast, Smooth and Sharp Fusion, Small Objects Filter or Outlier Removal, Hole Filling, Mesh Simplification, Remesh and Smoothing) with a press of only one button.

Figure 5.32: The extended Auto post-processing menu

To switch from Manual to Automatic mode, open Tools panel and choose Auto option in the dropdown list located in left corner of the section. Press button near the Go! to view all options available in Automatic Mode. Note that only Global Registration, Fast Fusion and Small Objects Filter are enabled by default. In order to perform other actions automatically, choose the On option in the dropdown list next to the required function or the Off option to exclude a function from Automatic Processing. Click Go! button or press Ctrl + G hot key combination to start the Automatic Processing.

All settings and parameters of algorithms are taken from the the Manual mode page. To change settings of algorithms, switch to Manual mode, change settings and run the Automatic Processing – all changes will be applied.

Keep in mind that all algorithms are performed in the same order as they are listed – starting from Rough Serial Registration and ending with Remesh. This means that if you want to run Small Objects Filter before Fast Fusion or Global Registration, you have to do it manually.

Unlike Manual processing, Automatic processing does not require constant attention of the user, so it is more convenient when processing large objects – you can configure the settings, start the processing and leave it for some time. It can also be successfully used for processing of objects of any size, reducing the number of mouse clicks to get the result.
5.8 Texturing

Artec scanners are equipped with color camera, allowing you to capture 3D surfaces with texture and expanding the range of objects available for scanning. Perform the following steps:

1. Make sure the Don’t record texture checkbox is cleared.
2. If necessary, adjust the frequency of capturing texture frames (see subsection 7.2.5).
3. It is advisable not to turn off the flash bulb.
4. In the Preview mode adjust the texture brightness by using the same name slider in the Scan panel.
5. Scan the object with any tracker. Captured frames are marked with the “T” letter in the surface view window (figure 5.2b).
6. Process the data and create a model, consulting the list in the beginning of the Chapter "Data Processing".
7. Run a mesh simplification algorithm for the model obtained (see subsection 5.6.6). This makes the texturing faster.
8. Use the Texture panel to apply texture to the model.

Texture mapping is a process of projecting textures from the individual frames to the fused mesh. Texture mapping assumes that the model was not moved or deformed (i.e. stayed in the same position as the scans that it was built from).

5.8.1 Texture mapping

3D model obtained after alignment and optimization contains no texture information. To map textures on a model, open Texture panel and select the fusion that you want to apply texture on in Select model list box (see figure 5.34). After fusion is selected, select the scans that the fusion was built from (and that thus have the required textures) in the second listbox.

Figure 5.33: Simplified illustration of texture mapping: texture as a single file

Note: It is not recommended to apply texture on the models undergone major changes in their geometry or orientation. Texture will be applied incorrectly to the model if you previously did either of the following:

- Transforming or positioning model relative to its source scans;
- Non-rigid alignment (see subsection 5.2.6);
- Erasing major parts of the model.
Next you will need to choose method for applying textures to the model. Two methods are available:

- **Generate triangles map**;
- **Generate texture atlas**;

The **Generate triangle map** method rasterizes all mesh triangles into texture images, individually duplicating UV coordinates for vertices and producing non-continuos texture (or textures). Size of triangles\(^2\) (see figure 5.35c) can be adjusted in pixels with the **Triangles size** slider in the panel. The resulting texture size can be selected from the drop-down list (maximum texture size depends on the capabilities of the graphics card). After changing the triangles/texture size, estimated number of textures will be displayed in the **Estimated** zone at the bottom of the panel, but the actual number may slightly differ.

The **Texture Atlas** method cut the surface into pieces, unfold and nest them on the flat and fit them into the image of specified size (see figure 5.35b and figure 3.11 in subsection 3.4.6). This method takes longer time than the triangle map method, but the texture obtained is much more convenient for manual editing.

If you want to modify texture by utilizing inpainting techniques, there are two options to choose:

\(^2\)Size of triangles is determined by the number of pixels per triangle side.
Inpaint missing texture option allows to apply texture to the regions with no texture information by spreading it from the neighboring regions.

Remove targets option does the same, painting out targets by applying surrounding texture to them (targets can be used to facilitate scanning (subsection 2.2.10)). Selecting this checkbox makes sense if you activated the remove_targets option when producing this fusion (Section 5.5).

There is one option called Enable texture normalization which is selected by default and aims to compensate for uneven lighting caused by movement of a scanner flash unit during scanning. It is not desirable to clear this checkbox.

Finally, select size of the texture and press Apply to start texture mapping process.

If you want to reduce or increase resolution (Result texture size) of the already mapped texture, you can remap it times faster thanks to the Use existing atlas UV option.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Texture distortion</th>
<th>Speed</th>
<th>Number of textures</th>
<th>Texture resolution management</th>
</tr>
</thead>
<tbody>
<tr>
<td>Triangles map</td>
<td>Does not keep aspect ratio of triangles</td>
<td>Fast</td>
<td>1 or more</td>
<td>Through adjusting triangle size and texture image resolution</td>
</tr>
<tr>
<td>Texture atlas</td>
<td>Keeps aspect ratio of triangles</td>
<td>–</td>
<td>Always 1</td>
<td>Through adjusting texture image resolution</td>
</tr>
</tbody>
</table>

Table 5.3: Comparison of the texture mapping methods

It should be noted that all surfaces, except those needed for texturing, are unloaded from RAM before mapping procedure. This is done in order to optimize computer resources usage. For more detailed description of project data selective loading into RAM see Section 4.7.

5.8.2 Texture adjusting

After the texture mapping process is complete, you will be able to adjust texture on the model (figure 5.37).
Note: You can always return to texture adjustment using the Adjust texture command in the context menu of the Workspace panel.

Figure 5.36: Hue, saturation and brightness representation

The following parameters of the texture can be adjusted with the corresponding sliders (see figure 5.36 for explanation):

- Brightness;
- Saturation;
- Hue;
- Contrast;
- Gamma correction.
Initial position of *Hue* slider bar corresponds to the current color of the texture. Dragging it to left or to right you bring out the color from the color wheel in a clockwise direction or in a counterclockwise direction.

After making the necessary changes, press *Apply* button to transfer obtained textured model into the *Workspace* panel.

### 5.9 Manual inpainting with Texture healing brush

You can manually inpaint missing texture by applying *Texture healing brush*. This tool is based on the same algorithm as the *Inpaint missing texture* option covered in subsection 5.8.1. Inpainting algorithm uses texture from the neighboring regions to fill in the regions with missing or incorrect texture. Figure 5.38a shows a small imperfection on the texture: a felt-tip pen mark on the actual figurine. Results of inpainting this region are given in figure 5.38b.

**Note:** Restoring texture on the regions that have been corrected with Defeature brush is not supported in this version of Artec Studio.

![Figure 5.38: Texture healing brush](image)

To launch the tool and inpaint texture:

1. Make sure the model that you are going to edit is marked with 🔍 icon.
2. Open *Editor* panel by clicking its icon on the side toolbar.
3. Select *Texture healing brush* by clicking the 🌳 icon.
   
   **Note:** Make sure the Select through toggle is in 🔍 position in 3D View window.

4. Select the desired mode: 2D selection or 3D selection.
5. Press and hold down Ctrl button while using Scroll wheel or [ and ] keys to adjust the tool size. The tool size should not exceed the size of the region with texture that needs correction.
6. Paint over the region of interest with LMB while holding down Ctrl button so that the tool (a circle or a spot) goes over problem area only. Try not to touch neighboring areas.

7. Click Apply to accept the changes or Cancel to revert them.

**Note:** If you paint the area where the actual number of polygons exceeds the value specified in the settings dialog (subsection 7.4.3), a message appears prompting you to either ignore the value and get ready for a longer processing, or cancel the operation.
Chapter 6

Additional modes

This chapter describes other Artec Studio modes, such as:

- Publishing to Viewshape (see Section 6.1);
- Multicapturing (see Section 6.2);
- Measuring tools (see Section 6.3).

6.1 Publishing to Web

Artec Studio is capable of publishing your 3D models on the Web, on www.viewshape.com. Viewshape is a service that uses WebGL to render 3D models in the web browser, which simplifies the process of collaboration among users. Published models can be seen on www.viewshape.com or be embedded on other websites, blogs or social networks. Any model can be shared privately, so only those who know the unique URL would be able to see, comment and use it.

Most browsers support WebGL at the moment. If this WebGL is disabled or not supported in a particular browser, www.viewshape.com displays 3D geometry as a pre-rendered set of images that can be rotated with a mouse. Such images are called spin images.

To publish a model, you need to open the Publish panel. It will open only if you have exactly one fusion selected in your Workspace window. Otherwise, the error message will be displayed. To log in to www.viewshape.com, please use your account from my.artec3d.com. In case the login process fails, login/password window can be accessed from the link in the top of the panel (see figure 6.1).

Upon successful login, you will see the window as shown on the figure 6.2. Follow the steps below to continue with uploading:

- adjust position of the model in the 3D View window to see how it will be displayed on the web;
- preview rotation, when necessary;
- choose one of the visibility options: Public or Private;
- choose whether to use WebGL on the web: Show WebGL to display full-featured 3D model and rotate it freely or Spin Image only to display images of the model captured from different angles and rotate them only around vertical axis;
- choose the license type for your model;
Figure 6.1: Viewshape.com login window

Figure 6.2: Publish panel

- and specify Collection in your Gallery, where the model will be published to (or create a
Beside all that, it is required to set *Model name* and optionally *Model description*. Once everything is completed, click *Publish* and your model will appear on the site.

**Model requirements**

WebGL is a progressive API, but it is not very powerful. If your model contains several million polygons and several very high-resolution textures, you will hardly be able to render it in a browser. That means that to get a good-looking model, you have to make it optimized. The recommended parameters of the model are:

- Less than 300,000 polygons;
- Texture of 1024x1024 (512x512 is better);
- Texture mapped with Atlas method (mandatory requirement);
- Model will be rotated around Y axis, so it should be positioned correspondingly.

Using the **LMB** in the *3D View*, you can rotate the model around its center of mass. As no translation is possible here, the model should be rotated to the position that you want it to appear on the web.

If model parameters do not satisfy the requirements and recommendations listed above, yellow notification will appear at the bottom of the window with suggestion to fix the issue and corresponding button.

**Fixing issues**

If some issues are found (as shown on figure 6.2), press the **Fix the issues** button and it will open the new panel as shown on figure 6.3.

Two types of issues can be found right now: very dense mesh and incorrect texture mapping. If the mesh is too dense, you have to fix it first of all by simplifying the model. The simplification tool can be found on the Fixing issue panel. If the texture is mapped with *Generate triangle map* method, it can be re-mapped by pressing the **Fix texture** button as shown on figure 6.3. After pressing the **Fix texture** button, the *Texture* panel gets open. In this panel you should re-map texture using *Generate texture atlas* method and recommended resolution.

When all the issues are fixed, click **Back to Publish** to return to *Publish* panel and continue publishing process.

**6.2 Multicapturing**

*Artec Studio* supports synchronized scanning with multiple scanners. This mode is useful when capturing a large object from several angles, using more than one scanner simultaneously. Multicapturing with several scanners implies that the system knows their position in advance. This considerably simplifies and speeds up data processing. This is why you have to calibrate the relative positions of the scanners before capturing. The resulting calibration data, which include scanner IDs and their spatial orientation, are referred to as a “bundle”.

102
You can bundle together Artec 3D scanners, third-party 3D sensors and any combination thereof. The only restriction is that the bundle should not include more than one Microsoft Kinect v2 or Intel RealSense camera \(^1\) devices.

Complete the following procedure in order to get the devices and the environment ready for simultaneous capturing a 3D video stream:

1. Calibrate the relative position of each device (i.e. create a bundle).
2. Use the Multi panel to capture scans.

To create a bundle perform the following steps:

- Capture the test object using all bundled scanners (see object requirements below in the subsection 6.2.1).
- Manually align the resulting scans by means of the Align tool to compute the relative position of all scanners.
- Create the bundle using the Create bundle panel.

**Note:** Once the bundle has been created, the scanners can not be moved relative to one another. The bundle has to be recreated if the position of even one device has changed!

\(^{1}\text{F200 or R200}\)
6.2.1 Bundle creation

Perform the following steps before creating a bundle for a set of scanners:

1. Select device positions. Scanners’ combined field of view should cover the required area.

2. Fix scanners in the chosen positions. If you plan to use hardware synchronization attach scanners to the tripods allowing the wires to hang freely and scanners to be sufficiently secured with thumbscrews.

3. Select and set up the calibration object. Any object with geometry-rich surface can be used. Objects with simple geometry should not be selected for calibration (e.g. planes, spheres, cylinders). Several objects as a composition may be used for bundle creation. Object installation is recommended at the distance corresponding to the middle of the operating range for device type in question.

Scanning can be performed using the Capture or Multi panels. The latter option is more convenient, as it allows capturing the video data stream simultaneously from several scanners. See details of this mode in subsection 6.2.2.

If scanners are installed at a small angle relative to each other (i.e. can see the same area of an object simultaneously) then the scanned object may be stationary. In this case calibration scans may be taken either sequentially one after another or concurrently.
**Note:** In case of sequential scanning make sure that the object is fixed safely and does not move during scanning.

If the scanners are set up at a large angle and their fields of view do not overlap, you should use the **Multi** panel to start the capturing sequence and then turn (move) the object in the way that would enable capturing the same parts of the object by all scanners.

**Note:** It is important that all scanners capture a large portion of the object or the scene (not necessarily the same portion) in each frame, because the position of all subsequent frames and the scanners themselves will be determined by their predecessors, and relative position of scans will determine intercalibration of devices.

If cameras are far away from each other, and the object was moving, then ready scans should be registered using **Fine serial registration** and **Global registration** algorithms.

Then proceed to the **Align** panel and align captured scans as it is described in subsection 5.2. When scans are aligned altogether, everything is ready for bundle creation. Select the menu item **File ➤ Create bundle**. A warning message will be displayed if you forget to align scans. Otherwise, you should see the bundle creation panel (figure 6.4). The **3D View** window will show the selected scans, the position and viewing direction of the scanners (shown by means of an appropriately colored pyramid), the device ID, and scanner coordinates. The panel will show a list of connected devices and corresponding information. A device can be added to the bundle or removed from the bundle by inverting the ⚫ image in the leftmost column of the list. Order of devices in a bundle refers to the scans order in the **Workspace** panel.

A bundle name will be displayed in the field at the top of the bundle creation panel. By default, it is made up of bundled scanner S/N. Before creating the bundle, you can easily change the name by typing it in this field. Press **Apply** button on the bottom of the panel to create and install the bundle.

### 6.2.2 Multicapturing

The **Multicapture** mode allows capturing 3D data streams simultaneously from several devices. Choosing this mode activates the relevant panel (figure 6.5a) that lets you choose device configuration: either use one of the existing bundles or specify the scanner list manually.

Choosing the **Use bundle** option will activate a drop-down list of bundles. It lists all installed bundles. Active bundles are highlighted in black, inactive bundles in gray. The bundle is considered active if all bundled devices are installed and connected to the PC. You cannot use a bundle if the number of devices included in it exceeds the number of processor cores in your PC (i.e. quadro core PC = up to 4 scanners in any bundle).

**Note:** In the multicapture mode the system possesses information about the relative positions of scanners. Therefore, scans made by bundled scanners differ from scans made manually in that the matching frames from different scanners are already in the same coordinate system after being captured.

Select **Synchronization type** in the **Options** tab of the **Multicapture** panel. In **Software** mode scanners are synchronized via USB, **Windows**, and Artec Studio, and slave scanner actuation time is always vary (~10 miliseconds) due to big number of links in chain. In **Hardware** mode scanners are synchronized via cables (see Appendix C for details). Hardware synchronization provides
Multicapture data can be stored either as separate scans (use radio-button *Separate scans*) or as a single scan in which every frame represents an aligned union of corresponding frames from all bundled devices (use radio-button *Merge frames*). If you need to capture frames not simultaneously from all scanners, but with a certain delay, enter the delay value in the *Delay between frames* field. Unlike the *Scan* mode, the *Multicapture* mode captures each frame independently without trying to align each subsequent frame with the previous one.

Sometimes, it is necessary to limit the cameras’ field of view (e.g. to cut off unnecessary objects at the far distance). A pair of sliders in the *Depth of field* field which set the near and far scanning boundaries respectively are designed for this purpose. Work area boundaries are set for each device independently at the device tabs (*figure 6.5b*). Recommended range for this device type is set as minimum and maximum boundary values by default. If you would like to change these values manually uncheck *Override default depth range* at the *Scan* tab of the Settings dialog. If
you are using L scanners or 3D sensors, you may change these values manually. To this end, select **Override default depth range** checkbox on the **Scan** tab of the **Settings** dialog.

**Note:** Redefining the recommended depth range may result in loss of accuracy.

If capture speed is crucial, use **Fast capture mode** by checking the relevant checkbox and entering the desired capture duration in seconds. In this mode, processor time is not wasted on building surfaces and rendering, but rather raw data is stored in the memory and frames are processed after the capturing sequence has been completed. When you change the duration of the fast capture period, the application will automatically recalculate and display the amount of memory required. Multicapture parameters are saved when you exit the application and reapplied the next time you start it.

### 6.3 Measuring Tools

There are several measuring and commenting tools in **Artec Studio** application. They include:

- Linear distance;
- Geodesic distance;
- Sections;
- Surface Distance Maps;
- Annotations.

The corresponding buttons are located in the top part of the **Measures** panels (see figure 6.6). A list of previous measurements is displayed in the panel below. After selecting the necessary measuring tool, the application displays a list of scans you may work with. After selection, the scan is displayed in the **3D View** window. Select all necessary scans and click the **Next** button; to return to tool selection click **Back** button. You may also return to the first **Measures** panel tab by clicking the **Measurements** link in the upper part of the panel. Otherwise, the selected measuring tool window will be displayed after clicking the **Next** button. Let’s take a closer look at the different measuring tools and their features.

#### 6.3.1 Linear distance

The linear measuring tool (figure 6.7) allows measuring distances between selected points and measuring the total length of a single string of multiple points. Click **button and select the scan in order to move to the **Linear** window. A name of the created measurement may be entered in **Name** field in the upper part of the window. The application creates new measurements with default names **Linear 1**, **Linear 2**, etc.

Indicate points to measure distances between them sequentially in **3D View** window by clicking the **LMB** on the model. The selected points will be added into the current measurement list where linear dimensions and point coordinates will be displayed. When the cursor rolls over any one of these points in the **3D View** window, the point is highlighted red – the point can then be dragged to another location using the **LMB**. The point will be set in the new location after the mouse button is released. A point cannot be set outside the object’s surface; in this situation, if the mouse button is released, the point will return to its original position.
You can see the total number of points and total length of measurements in the left panel. You can also hide scans in 3D View with Hide source data checkbox, display sequential point numbers with Show numbers checkbox, display measurement labels on the model with Show labels checkbox by selecting or deselecting the appropriate checkbox on the panel. You may also select the color of labels and lines by pressing the Label color button.

To start a new measurement chain on the same dataset click the Make another button in the lower part of the panel. Artec Studio will clear the 3D View window of all measurements and display an empty left panel.

Measurement can be exported in a .csv or .xml file by pressing the Export button.

After pressing the Apply button, the application will return to the first panel Measures, where a list of all saved measurements will be displayed along with editing and deletion options.

### 6.3.2 Geodesic distance

Geodesic distance is defined as the length of the shortest path over surface between any given points. Click 📝 button on the Measures panel and select a scan to start the tool.

**Note:** Only scans containing one surface will be displayed in the geodesic measuring tool selection panel.

Work with geodesic measurements is similar to work with linear measurements (figure 6.8). Keep in mind that the shortest path between different surfaces or disconnected parts of the same surface does not exist. Therefore, the program will display an error if points are selected on parts of a surface that are not connected to each other. Calculation of the shortest path is a time-consuming process that will be accompanied with progress bar window.
Note: The geodesic algorithm is complex, and computations for a large number of vertices may take significant time. Therefore, when choosing the first point on the surface where the total number of points is more than 150,000, the software issues a warning that it may be a time consuming operation. You may either use the mesh optimization algorithm beforehand (see subsection 5.6.6) or delete parts of the surface you do not need.

Left panel in this mode is similar to one displayed in linear measurements mode (see subsection 6.3.1).

6.3.3 Sections as means of measuring area and volume

To create section object (figure 6.9) click the button in the Measurements panel and select one or more scans. After clicking Next, you may change the section name in the Name field of the panel appeared. By default, the application creates new sections with names Section 1, Section 2, etc.

Now you can define section:

1. Indicate with LMB points on the surfaces:

   (a) Only one point for plane to be placed in parallel with one of the coordinate planes (XOY, YOZ, XOZ).
   
   (b) Three points to get the plane passed exactly through them.
(c) Several point for plane passing through their center of mass.

2. Before you Create section, you can press Clear points and redefine points.

3. Press Create section. If necessary, redefine plane. Click Change position button and select one of the tools: Translate, Rotate, Scale. You may either specify numeric values (in global coordinate system) in the text fields or drag controls (see figure 5.7) in 3D View windows. For instance, enlarging the Scale for the plane defined in the way described in 1b would result in this plane crossing the whole surface. Confirm you changes by pressing Apply button.

4. You can set up creating a series of sections. For that specify quantity of planes you want to create by entering numeric value in Number of planes field and define spacing in Sections offset, mm field. Then select from the Direction list one of three directions (Positive, Negative or Both) in which new planes will be created.

5. To save your changes press Apply or click Measurements link in the upper part of the panel. To save changes and proceed to creation of the next plane click Make another section.

As the section has been created, the geometrical information is displayed in the Section panel. Geometrical information includes perimeter and area for closed contours and area and volume for meshes. If section object consist of several planes, these data are grouped by the planes. Besides displaying geometrical values, list of meshes and contours allows to highlight them in 3D View with different colors when selecting:
Figure 6.9: Sections

- **Blue** (figure 6.10a) if the contour is not closed.
- **Yellow** (figure 6.10b) if the contour is closed.
- **Red** (figure 6.10c) may be applied to the currently selected contour or the polygons under (above) selected plane. For toggling between polygons displayed, click the **Invert Direction** button.
- **Green** (figure 6.10d) corresponds to second scan in the list if a pair was selected with Ctrl. Simultaneously Artec Studio calculates the difference between areas and perimeters of these contours.
- **Several shades of red** denote polygons belonging to one mesh (dark red in figure 6.10e) and to several meshes (from brighter red till the brightest red in figure 6.10f). When a pair of meshes is selected, calculation of difference between volume and square is also performed, and results are displayed in the lower part of the left panel.

If you want to turn multiple section set into several separate sections, click the **Convert to multiple sections** button. You will be notified of the successful operation and new objects will appear in Measurements list.

Every object in the Measures panel can be exported in CSV, XML or DXF files by checking it and clicking **Export** button. Several objects can be exported at a time. Export can also be
implemented for each section individually. Select one section and enter editing mode by double-clicking it with LMB. Then click Export button.

6.3.4 Surface distances maps

It is often necessary to compare two models and assess form deviation. Accuracy control may require to compare original model with the scanned one. These tasks can be solved by using Surface distance map.

**Note:** Only scans containing single surface can be used for comparison.

To use this tool:

1. Click the button on the Measures panel.
2. Then select two models for comparison and click the Next button.
3. If necessary, specify the name of the distance map in the Name field of the left panel (figure 6.11). By default the application creates new distance maps with names Map 1, Map 2, etc.

   **Note:** The direction along the normals of the first scan is considered as positive, the opposite direction is considered as negative. The button swaps scans.

4. Specify the Search distance value, a maximal range in millimeters (mm) for calculation distances between surfaces. You can adjust the actual range within this value after the calculation completes.
5. Click Calculate. Once calculation is complete, the distance map appears in the 3D View window as well as calculation results in the left panel (figure 6.11).
You can analyze obtained calculation results and distance map:

- Based on the entered value of the Search distance parameter, there are calculations results:
  - $RMS$, or root mean square is the square root of the arithmetic mean of the squares of the actual distances
  - Mean absolute deviation
  - Mean of signed distances.

- Distance map is a colored rendering on the particular regions of surfaces. Corresponding values of distances and their distribution can be read from the graduated scale with histogram that are located nearby. Map color changes from blue which corresponds to negative distance to red that corresponds to positive distance.
  - Green means that the distance between surfaces in this region is close to zero.
  - Grey highlights surfaces with distances that are out of the specified Search distance.
  - Orange and bright blue colors correspond to the distances that are slightly above and below the limiting values of the scale, respectively.

- Graduated scale ranges from positive to negative value of the Error scale. You can adjust the range of the scale by using the Error scale slider or textbox. Its maximal value can not exceed the Search distance value.
If you move the mouse cursor to the particular point on the map, exact distance will be displayed nearby and in the Distance at cursor field in the left panel.

To save the current distance map and quit this mode, click the Apply. If you want to save the current map and create another one, click Make another map.

**Note:** Surface distance maps are supported by annotations. You can use any saved distance map in the Annotation mode (subsection 6.3.5).

### 6.3.5 Annotations

Noteworthy elements of the surfaces or surface distance map can be marked using Annotations tools. The annotation may include one or several labels. Labels look like rectangular tags with connecting lines pointing to the elements on the surfaces (figure 6.12).

To create an annotation:

1. Click the button on the Measures panel, select one or more scans and click the Next button.

   (a) If you want to annotate a previously obtained surface distance map, select the required map from the Distance map list.

2. You can also specify Annotation name in the upper part of the panel or proceed with your annotation accepting a default name.

   ![Figure 6.12: Annotation of the model layered with a surface distance map](image)

3. Click LMB on the target point of the surface in 3D View window, the label appears alongside and a text cursor starts blinking in Annotation text field on the left panel.
Note: It is not possible to redefine target point of the label. So, if you were not so accurate in specifying a point on the surface, the only way to fix it is to add a new one (repeat step #3) and delete the incorrect one (consult the instructions below).

4. Type a text your annotation and it will appear both in the text field on the panel and in the label in 3D View window.

5. Repeat steps #3 and #4 to create a new label. Every new label in addition to tagging on the surface will be added to the annotation list on the left panel (figure 6.12). Labels in the list can be hidden/shown or recolored by clicking RMB and selecting a corresponding option in the menu. The same results can be reached by toggling Selection flag ☰ for displaying and by pressing the square button for recoloring.

You can adjust position of the label (the rectangular tag itself, not its target point!) by pressing and holding LMB in 3D View window, while moving mouse cursor. Unnecessary labels can be deleted in one of the following ways:

1. Select the label in 3D View window and its border color becomes red (see selected label in the figure 6.12). Press Del key on the keyboard.

2. Select the label from the list, then either press Del key on the keyboard or click RMB and choose Delete from the menu.

Annotations (more exactly, labels coordinates and titles) can be exported in a CSV or an XML file by pressing the Export button either on the Annotations panel or on the Measures panel.

You will be offered a file name equal to the name of annotation. Accept it or type another name. To complete annotation press Apply button in the bottom of the left panel or click Measurements link in its upper part.
Chapter 7

Settings

This chapter describes the Artec Studio settings which can be changed via the Settings dialog. To display this dialog select Settings... from the File menu or use a shortcut F10.

All settings are divided into categories located under separate tabs. The following setting categories are available for editing:

- General;
- Performance;
- Scan;
- UI;
- Language.

7.1 General

The General tab contains basic settings of Artec Studio application and includes the following options (figure 7.1):

- Projects storage folder;
- Autosave options;
- Import/Export options;
- Default import/export units;
- View control settings.

7.1.1 Project storage path

Set the folder where projects will be saved by default by typing in the path or selecting it from a dialog by clicking the Browse... button.
7.1.2 Autosave options

When option *Save project before algorithms start* is selected, the application always saves projects before starting an algorithm. The checkbox *Restore loading state of scans after algorithms finish* allows to control loading of selected scans after the algorithm is finished. Selected scans are always loaded into RAM before an algorithm is launched. If the scan is unloaded when the algorithm is launched, it will be automatically saved onto the hard-drive after the algorithm is completed, thereby freeing up RAM. For more information about auto-saving projects, see subsection 4.8 section of this manual.

7.1.3 Registering Artec Studio as default viewer

*Artec Studio* software supports various file formats. To make *Artec Studio* the default viewer for supported file formats, click the *Change...* button and select formats which the application will open by default (figure 7.2):

- *.sproj* – project files of *Artec Studio* application.
- *.scan* – single project scans export/import format.
- *.ply* – format for saving polygonal models obtained by laser scanners.
- *.stl* – 3D models export format for fast prototyping equipment.
* .wrl – virtual reality files in VRML 1.0 and VRML 2.0 format.

* .obj – texturized 3D models - Wavefront OBJ format.

Figure 7.2: Registration of files types opened by the Artec Studio application

For more information on import and export, see subsection 4.4, subsection 4.5.

7.1.4 Files open mode

The Artec Studio can be used as a default viewer for SPROJ, SCAN, PLY, STL, OBJ, VRML (*.wrm) formats. To open each new file in a new application window, select Open new model in a new window. If Open new model in the same window option is selected, Artec Studio will use previously launched windows to open new files.

7.1.5 Surfaces consistency detection during import

Select one of the following parameters:

- **Do not detect** – automatic surface consistency detection is turned off.
- **Detect & ask** – automatic surface consistency detection is turned on, and a user is prompted to start defect correction.
- **Always detect & fix** – automatic surface consistency detection and automatic correction is turned on.

7.1.6 Model placement

When exporting, scans or models can be automatically placed on the center of axis grid. To enable this option, select the Move model to the origin of the axis grid during export checkbox. If the checkbox is cleared, the current placement of the model on the axis grid will be saved for the surfaces to be exported.

7.1.7 Units

In Artec Studio, all software operations use millimeters as the default measurement unit. If you need to import or export a model in other dimensional units, use the Units section. These settings are applied only during import or export of a specific model.

Selecting option Show unit selection dialog on import enables the user to choose what measurement unit the scan was created in on import (figure 7.3). The following units of measurement
are available: millimeters, centimeters, inches, meters. If in most cases you import data in particular measurement units, but there is a possibility of importing models that were created using other measurement units, then you should enable the option *Only if object is less than __ mm* and enter the threshold value. In this case, the window of unit selection will be available only if the dimensions of the loaded model do not exceed the threshold value.

The drop-down lists *Default import units* and *Default export units* set up the default measurement units for exporting and importing models.

![Units selection window](image)

**Figure 7.3: Units selection window**

### 7.1.8 View control settings

Zooming in 3D View window with *Scroll wheel* can be set as follows:

- Clear *Wheel mouse zoom: to cursor mode* checkbox to enable zooming to the center of the screen. In that case you have to keep the target area in the screen center and readjust its position from time to time.

- Select *Wheel mouse zoom: to cursor mode* checkbox to enable interactive zooming to the mouse cursor position. In this mode you just have to keep the cursor on the target area while spinning the *Scroll wheel* forward and back.

### 7.2 Performance

The following parameters can be adjusted under the *Performance* tab (figure 7.4): multithreading, memory usage, command history storage, compression levels of stored data, texture recording mode and Real-time fusion settings.

#### 7.2.1 Multithreading

On the computers featuring multi-core processor, *Artec Studio* uses all cores by default. If you would like to limit the number of cores used, clear the *Use all available processors* checkbox and enter the number of concurrent threads manually.

#### 7.2.2 Memory

RAM availability is shown here. If it is insufficient, you can try to increase it by pressing the *Compact memory* button. *Artec Studio* will clear the command history and will try to optimize allocation of RAM. Clicking *Compact memory* will not delete history permanently, but rather
just unload it from RAM. It will be loaded back, if the “undo” command is activated. For more information about project saving, see subsection 4.6.

**Note:** Command history cannot be unloaded from memory if the project is not saved. Save it and try again.

### 7.2.3 History of commands

In this section, you can limit the amount of history to be saved. By default, maximum values are set for number of commands and size on disk (in Mb). If necessary, you can clear the Max. length of history checkbox. This will mean that the program will save all history for each project from the beginning. You can clear project history by clicking the Clear history of commands button; the application will prompt for user confirmation to complete this action.

**Note:** Once history is cleared, it is impossible to return to an earlier project version.

### 7.2.4 Data compression level

The slider in the Data compression level section, allows the user to change level of file compression when saving data. Higher compression saves disk space, but loading and saving these scans
take longer. These settings apply to both projects and SCAN files.

7.2.5 Texture recording mode

By default (Automatic texture recording), texture is captured not in every frame. But you may manually specify the frequency of capturing texture frames by using the spinner Record texture every __th frame.

7.2.6 Real-time fusion settings

The Real-time fusion settings are presented by two options: Voxel size (mm), in other words, fusion resolution and Dimensions (lower - faster), that is one dimension of scanning zone (zone is treated as a cube of side, which size is equal to the specified dimension value). For details, see subsection 2.2.9.

7.3 Scan

The Scan section allows for editing parameters used by the application both during scanning itself and for post-processing (figure 7.5).

![Figure 7.5: Scan settings page](image)

7.3.1 Algorithms settings

Settings for each scanner type are automatically selected and displayed in the Current scanner type drop-down menu. If this does not happen, select the appropriate scanner type manually. While using the application, you may need to manually change algorithm settings. To reset all settings to their default values, click Reset to defaults.

Current user preset allows users to save parameter values specified in Tools panel. Having selected a saved preset, you change all settings at once. Note that Current user presets is applied only for the selected device type.
7.3.2 Photogrammetry settings

Photogrammetry settings allow to define target size. *Inner target diameter (mm)* corresponds to the diameter of white circle in the middle of the target, *Outer target diameter (mm)* corresponds to the outer diameter of black ring in the target. The most popular targets have diameters sizes "6" and "12" mm, values "5" and "10" correspond to Scan Reference target size. See subsection 2.2.10 for details.

7.3.3 Realtime

This section covers settings related to the trigger button for MHT, scanning depth range and individual frames acquired during scanning.

First option available here is the *Trigger mode for device button* checkbox that changes behavior of the button on the MH and MHT scanners and is described in details in subsection 2.2.12.

The scanner has a defined depth range. If the scanner is too close to the object during scanning, the object or its parts may not get digitized. On the other hand, if the scanner is too far from the object, various 3D "noise" will be added to the scene that will make post-processing difficult and affect the final outcome. Therefore the scanner should be positioned as close as possible to an object without crossing the cut-off plane. Default settings for each 3D scanner contain minimum and maximum limits within which cut-off planes may be positioned. These values are determined based on the model of the scanner. However, if you are using L scanner or 3D-censor and high accuracy is not of great importance, depth boundaries can be adjusted manually, which will allow the user to scan closer to or further from the recommended distance to the object. To this end, select *Override default depth range* checkbox and enter new range values.

*Note:* Redefining the depth range may result in loss of accuracy.

The *Auto-alignment during the scanning* option is enabled by default and covered in Losing and resuming tracking and Continue scanning from scans selected in Workspace paragraphs.

Another option affecting tracking is *Misalignment detection for EVA scanner* (see Misalignment detection paragraph). Set in Hybrid tracker only by default, this option may improve user scanning experience with EVA scanner with Geometry + Texture tracker. It can also be turned *On* or turned *Off* for all trackers, including Geometry.

Artec Studio software allows you to change characteristics of single frame surfaces coming from the scanner. To change default parameters, uncheck *Use default realtime settings* and change settings manually in the displayed window. The following settings are available for editing:

- **Triangles Step:** points density of a frame mesh.
- **Minimum object size:** minimum size of object scanned by number of polygons.
- **Length filter threshold:** triangle filtration threshold by edge length (maximum possible size in mm).
- **Interpolate:** interpolation on/off for those parts where the data is missing.
- **Max Interpolated Length:** maximum size of interpolated areas (in mm).
- **Max Angle:** triangle filtration threshold by maximum angle (in degrees) between triangle’s normal and sight vector of the camera.
- *Registration geometry quality*: the weight factor defining the importance for registration during scanning of geometry information in comparison with texture information. When the value is close to 0, algorithm takes into account only geometry and considers the texture at 100. Works with Hybrid tracker only.

**Note:** *We recommend using default settings. Inappropriate settings may lead to loss of data quality.*

### 7.4 UI

UI page allows user interface settings editing ([figure 7.6](#)) and includes the following settings groups:

- Sound notification;
- Workspace colors;
- Warnings;
- Surfaces that display during scanning.

#### 7.4.1 Sound notification

Sometimes automatic, real-time alignment is not possible during scanning and the program cannot align the previous frame with the current one (see subsection 2.2.2). When that happens, Artec Studio issues an audio warning that stops once the scanner is repositioned and the software can find its place in 3D again. To turn on/off this feature, mark the checkbox *Switch on sound signals in Scan mode*. Standard sound fragment "bell-ring" is played by default. You can choose any WAV file to be the warning sound.

**Note:** *Audio warning during scanning is possible if the computer is equipped with a sound card and speakers.*

#### 7.4.2 Workspace colors

The Artec Studio application automatically chooses display colors for newly created scans. You may select one of the standard palettes:

- Full palette;
- Light colors;
- Web-safe colors;
- Random colors;
- Monochrome.
7.4.3 Warnings

This group of settings allows you to turn on/off certain warning messages. They include:

- **Warn on exit if project has unsaved changes.** If enabled, it warns user that unsaved data will be lost if the application is closed without saving.

- **Show OpenGL compatibility issues on startup.** Artec Studio requires OpenGL version 2.0 and some OpenGL extensions to function properly, which may or may not be installed on your PC. Selecting this option activates a display window containing information on possible missing extensions on start up.

- **Texture healing brush: Warn if over ___ polygons are selected** checkbox serves to warn about exceeding the maximal number of polygons to be inpainted at once. This limit helps to prevent computer from possible hanging up. Specify the value that is suitable for your computer or clear this checkbox if you do not need warnings of this kind.

7.4.4 Displaying in 3D View window

You can change the way you see surfaces and points during the scanning process, adjust their colors and background color, set up mode of playing frames. The following settings are available for editing:

- "Display" settings group
- Last Scanned Surfaces: number of newest captured and visible surfaces that are displayed during scanning in 3D View.
- Visible Surfaces: total number of visible surfaces during scanning (equals to number of last scanned surfaces + number of key frames to show).
- Simple Rendering Mode: number of points in the viewport that switch the display to simple rendering mode during 3D navigation.
- Point size defines number of pixels for rendering every point in ‘Points’ and ‘Points and Solid’ render modes.

- "Colors" settings group
  - Last: color of last scanned surfaces.
  - Registered: color of correctly aligned surfaces.
  - Preview: color of surfaces in preview mode.
  - Dropped: color of not aligned and thus dropped surfaces.
  - Keyframes: color of key surfaces.

- "Playing" settings group (see subsection 5.1.1)
  - Playing Repeat: continuously loop the playback of frames in the surface panel.
  - FPS: Speed (“frames per second” rate), at which frames appear during playback.

- "Background" settings group (see figure 7.7)
  - Color – Changes the color of actual background.
  - Dropped Color – Changes the color of background during misalignment while scanning.
  - Texture – Allows you to set a checkerboard pattern as a background.
  - Gradient – Uncheck to switch the background color to monotonous.

- "Welcome screen" settings group
  - Don’t show – if selected, it disable the welcome screen.

Figure 7.7: Example of altered background
7.5 Miscellaneous

7.5.1 Usage information

Help us improve the quality and performance of Artec Studio by allowing to collect and send usage information to Artec Group. This information will not be used to identify you and does not include your project data, 3D surfaces, texture and any other data obtained and processed in Artec Studio. By default, the Collect and send anonymous usage data to Artec checkbox is selected. We do not recommend to clear this checkbox.

When installing the application, you can decide whether to collect and send usage data. The checkbox of the same name appears in the final dialog (figure 1.8f).

Figure 7.8: Miscellaneous page

7.5.2 Language

Artec Studio application interface is translated into many world languages:

- Auto – automatic language selection according to system settings;
- Chinese (Simplified) – Chinese (Simplified);
- English (US) – English;
- French – French;
- German – German;
- Italian – Italian;
- Japanese – Japanese;
- Polish – Polish;
- Portuguese – Portuguese;
- Russian – Russian;
- Spanish – Spanish.
To switch between languages, choose the one you want and click OK. The program will then prompt for a restart. If user agrees, application will restart automatically with newly selected interface language. If you choose not to restart, changes will take effect upon the next start of the application.

**Note:** *Changing the language will require Artec Studio restart.*
Chapter 8

Scanner calibration and correction

*Diagnostic Tool* is a special utility used for calibrating Artec 3D scanners and applying corrections for the existing calibration. In general, calibration is a process of checking and adjusting measurements made by the scanner through comparing them with the standard (etalon) values. Every Artec scanner is delivered pre-calibrated.

Due to careless handling or transportation (jolting, accident drop, some other reasons), scanner may become unable to capture surfaces properly. In this case surfaces being scanned may be partially reconstructed, holes may appear (results of bad reconstruction are noticeable on the blue surface, see figure 8.5). These issues can be fixed through applying correction or calibration.

Depending on the scanner model, *Diagnostic Tool* can operate in one of the three working modes:

1. correction for MHT, MH, L and EVA scanners;
2. correction for Spider scanner;
3. calibration of Spider.

*Note: Calibration is only available for Spider scanners.*

8.1 Suggestions for use

Correction differs from calibration in that the correction preserves the current calibration, changing only correction ratio for the sake of good reconstruction. The accuracy of geometric shape and linear measurements is not guaranteed in case of applying correction.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Peculiarities</th>
<th>Speed</th>
<th>For Spider</th>
<th>For EVA, L, MHT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Correction</td>
<td>Not exact</td>
<td>Fast</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Calibration</td>
<td>Exact (^1)</td>
<td>Prep is needed</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

Table 8.1: Choosing between calibration and correction

\(^1\)Restores the original values stated in the device specifications.
8.2 Launching Diagnostic Tool

First make sure that scanner you intend to diagnose is displayed in Artec Installation Center as Rented or Activated. You can launch Diagnostic Tool either through Start menu by clicking Start → All Programs → Artec Group → Artec Studio 9 → Diagnostic Tool, or in Artec Studio by selecting Run Diagnostic Tool command in the File menu.

If several scanners are connected, select the required one from the dropdown list.

![Diagnostic Tool window](image)

**Figure 8.1: Diagnostic Tool window**

The utility's window is divided into three sections: 3D View window and right panel and toolbar (see figure 8.1).

8.3 Scanner correction

8.3.1 Correcting calibration data for EVA, MHT, MH and L scanners

For EVA, MHT, MH and L scanners it is only allowed to correct the current calibration settings.

1. Launch Diagnostic Tool as described in Section 8.2.

2. Select the scanner you intent to diagnose.

3. Click **Start diagnostic** or press ▶ button, the scanner will start preview, range meter will appear in 3D View window and the right panel with 2D camera preview window will open.
4. Point the scanner at the right angle to a flat light, but not shiny monochrome surface, e.g., wall or floor from a distance of 650–700 mm for MHT, MH, EVA scanners and 850–900 mm for L scanners. The surface will be rendered in blue color in 3D View window.

**Note:** If the rendered surface is not flat and has holes, it is worth performing the correction.

5. Click **Start correction** or press ▶ button on the scanner body. In addition to the blue surface, an yellow surface will appear in 3D View window. The blue one corresponds to the surface captured with original calibration data, yellow one stands for the surface captured with corrected calibration data.

6. Two indicators on the right panel can help you assess the surface quality (green stands for good results, yellow for satisfactory and red for unsatisfactory results). If the corrected (yellow) surface does not have any hole and is flat enough, and correction results meet your expectations, click **Commit** or press ▶ button on the scanner body. Otherwise, click **Rollback** or press ▼ on the scanner body.

### 8.3.2 Correcting calibration data for Spider

Correction for Spider slightly differs from correction for MHT and EVA scanners.

1. Launch **Diagnostic Tool** as described in Section 8.2.
2. Select the Spider from the list.

3. Click Start diagnostic or press ▶️ button, the scanner will start preview, range meter will appear in 3D View window and the right panel with 2D camera preview window will open.

4. Point the scanner at the right angle to a flat light monochrome surface, e.g. a wall from a distance of 190–270 mm. It will be rendered as a blue plane in the 3D View window.

   **Note:** If the surface from the distance, corresponding to the middle of the range, is not rendered as flat or has holes, it is worth performing the correction.

5. Place the scanner on a desk or attach it to a tripod, keeping a distance of 190 mm from the flat surface (see the range meter in the 3D View window).

6. Click Start correction or press ▶️ button on the scanner body. A red mark will appear on the range meter.

7. Smoothly move the scanner towards the flat surface in a way that histogram peak coincides with the red mark on the range meter (see figure 8.4).
8. The next red mark will appear higher on the range meter. Smoothly move the scanner away from the flat surface in order to approach the red mark.

9. Repeat the step #8 three more times. As you finish, the calculation will start and the yellow plane corresponding to the surface captured with corrected calibration settings will appear in 3D View window (see figure 8.5).

10. If this yellow surface does not have any hole and is flat enough, and correction results meet your expectations, click Commit or press button on the scanner body. Otherwise, repeat steps 7–9 or click Rollback or press on the scanner body. Two indicators on the right panel can help you assess the surface quality (green stands for good results, yellow for satisfactory and red for unsatisfactory results).

Figure 8.4: Spider’s positions and corresponding distances on the range meter

Figure 8.5: Spider correction results
8.4 Spider calibration

To carry out the calibration, you will need the following additional facilities: calibration rig, scanner stand and pattern. Assembly instructions for scanner stand and rig are given in Appendix E and Appendix F, respectively.

![Figure 8.6: Calibration facilities](image)

**Figure 8.6: Calibration facilities**

1. Unfold the pattern and place it on a desk or on any plane and hard surface.

2. Place the scanner stand on the marked rectangle area of the pattern, paying attention to orientation of the slots in the stand cover (see figure 8.6a).

3. Place the scanner on the scanner stand, making sure that three scanner stems are inserted in the three slots in the stand cover (see figure 8.6b).

4. Place the calibration rig on the pattern, turning its marker side towards the scanner as shown in the figure 8.7.

5. Launch **Diagnostic Tool** as described in Section 8.2.

   **Note:** Calibration should be carried out after the scanner has been heated to the optimal temperature.

6. Click **Start calibration**. In the dialog box that opens (figure 8.8a), enter a serial number of your calibration rig (it is marked on the board). If the scanner temperature is out of the optimal range, for example, the device has just been connected to a power outlet, you will be notified with the message (figure 8.8b). It is not recommended to click the **Skip** button, but wait patiently until the Spider reaches an optimal temperature.

7. Place the rig to its initial position in such a way that the front edge of the rig base coincides with No.1 color line on the pattern. While matching, also watch 3D View window for a red plane (current position) and a green plane (target position) (figure 8.9). Once the red plane has coincided with the green one, stop moving the rig and wait until the plane is captured.

8. Once it has been done, you are asked to replace the rig to the next position on the pattern, number of which appears on the screen. Replace the rig and wait till the scanner captures it.
Repeat the preceding step for the remaining positions sequentially. Depending on the version of calibration kit supplied, there are from 11 to 15 positions on the pattern.

Once the last position has been captured, and the calculations have been finished, the message appears prompting you either to overwrite the existing calibration or to keep the current one. Before you make a decision, point the scanner at an antiglare flat surface (e.g. a piece of paper) from a distance of about 200 mm. Assess the quality of surface being
11. Click *Yes, apply the calibration* if no holes appear on the surface, and you are satisfied with the reconstruction results. To reject new calibration, click *No, keep the old one* (figure 8.10).

### 8.5 Notes on scanner’s calibration files

Calibration and correction results are recorded in the files which can be accessed as follows:

*C:/Users/John/AppData/Artec/Artec Installation Center/Devices/SP.00.00000000*

Where John is the current user’s folder and SP.00.00000000 is the folder corresponding to the scanner S/N.
There are several statements about calibration and correction.

- Applying results of correction is followed by ACD file creation.
- Upon applying calibration results, ACD and CORR files are created.
- All newly created files have names of the YYYYYMMDD_HHMMSS mask, corresponding to the date and time of their creation.
- Original ADD and CORR files names are based on scanner S/N and look like this: SP.00.00000000.

**Note:** You may restore initial calibration by removing ACD and CORR files with names like this: 20131121_101010.

**Note:** If the scanner is used on several computers, there is no need to re-calibrate it on every machine. It might be enough to just copy ACD and CORR files to the mentioned above folder on every PC.
Appendix A

Artec Scanners: LED indication and Buttons

LED indications

Multicolor indicators are built into Artec scanners. See the list below to keep track of the scanning process:

- ■ Steady blue – scanner is booting up.
- □ Flashing green - Artec Studio cannot detect a 3D scanner.
- ■ Steady green – scanner is connected to the application and ready to be used.
- □ Flashing red – scanner is in the Preview mode or tracking in the Recording mode is lost.
- ■ Steady red – scanner is in the Recording mode and object is being tracked correctly.

Hardware buttons

EVA and Spider 3D Scanners have three-position buttons on their bodies:

- ▶ button - you press it once and it opens the Scan panel and starts Preview mode; you press it one more time, it switches 3D Scanner to the Recording mode. The subsequent pressings will switch between Preview and Recording.
- ■ button - if pressed once during scanning, it stops the scanning process; if pressed twice, it stops the scanning and closes the Scan panel.
## Appendix B

### Hot keys

<table>
<thead>
<tr>
<th>Hot Key</th>
<th>Function</th>
<th>Where to press</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 (Numpad) or Ctrl+Shift+1</td>
<td>Switch viewpoint to Front</td>
<td>3D View window</td>
</tr>
<tr>
<td>Ctrl+1</td>
<td>Switch viewpoint to Back</td>
<td>3D View window</td>
</tr>
<tr>
<td>3 (Numpad) or Ctrl+Shift+3</td>
<td>Switch viewpoint to Left</td>
<td>3D View window</td>
</tr>
<tr>
<td>Ctrl+3</td>
<td>Switch viewpoint to Right</td>
<td>3D View window</td>
</tr>
<tr>
<td>7 (Numpad) or Ctrl+Shift+7</td>
<td>Switch viewpoint to Top</td>
<td>3D View window</td>
</tr>
<tr>
<td>Ctrl+7</td>
<td>Switch viewpoint to Bottom</td>
<td>3D View window</td>
</tr>
<tr>
<td>5 (Numpad) or Ctrl+5</td>
<td>Toggle between perspective and orthogonal views</td>
<td>3D View window</td>
</tr>
<tr>
<td>F7</td>
<td>Start scanning (activate Preview mode)</td>
<td>Anywhere exc. modal dialog</td>
</tr>
<tr>
<td>Space</td>
<td>Toggle between Preview and Record modes</td>
<td>Scan panel</td>
</tr>
<tr>
<td>F8</td>
<td>Open Multicapture panel</td>
<td>Anywhere exc. modal dialog</td>
</tr>
<tr>
<td>Ctrl+G</td>
<td>Start Automatic processing</td>
<td>Anywhere exc. modal dialog</td>
</tr>
<tr>
<td>F10</td>
<td>Call Settings dialog</td>
<td>Anywhere exc. modal dialog</td>
</tr>
<tr>
<td>F11</td>
<td>Show/hide Workspace panel</td>
<td>Anywhere exc. modal dialog</td>
</tr>
<tr>
<td>Ctrl+Alt+L</td>
<td>Show/hide Log window</td>
<td>Anywhere exc. modal dialog</td>
</tr>
<tr>
<td>Ctrl+Shift+S</td>
<td>Save screenshot</td>
<td>Anywhere</td>
</tr>
<tr>
<td>Ctrl+N</td>
<td>Create new project</td>
<td>Anywhere exc. modal dialog</td>
</tr>
<tr>
<td>Ctrl+S</td>
<td>Save project</td>
<td>Anywhere exc. modal dialog</td>
</tr>
<tr>
<td>Ctrl+O</td>
<td>Open existing project</td>
<td>Anywhere exc. modal dialog</td>
</tr>
<tr>
<td>Ctrl+Shift+O</td>
<td>Open existing project with scans unloaded (for RAM memory saving purposes)</td>
<td>Anywhere exc. modal dialog</td>
</tr>
<tr>
<td>Ctrl+I</td>
<td>Import 3D files</td>
<td>Anywhere exc. modal dialog</td>
</tr>
<tr>
<td>Ctrl+Alt+H</td>
<td>Clear history of commands</td>
<td>Anywhere exc. modal dialog</td>
</tr>
<tr>
<td>N</td>
<td>Enable/disable displaying normals</td>
<td>Anywhere</td>
</tr>
<tr>
<td>B</td>
<td>Enable/disable displaying boundaries</td>
<td>Anywhere</td>
</tr>
<tr>
<td>F1</td>
<td>Open user guide file</td>
<td>Anywhere</td>
</tr>
<tr>
<td>Ctrl+T</td>
<td>Open Tools panel</td>
<td>Anywhere exc. modal dialog</td>
</tr>
<tr>
<td>Hot Key</td>
<td>Function</td>
<td>Where to press</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------</td>
<td>-------------------------------------</td>
</tr>
<tr>
<td>Ctrl+L</td>
<td>Open Align panel</td>
<td>Anywhere exc. modal dialog</td>
</tr>
<tr>
<td>1</td>
<td>Display scans/fusions already aligned</td>
<td>Align panel</td>
</tr>
<tr>
<td>2</td>
<td>Display scans/fusions to be aligned</td>
<td>Align panel</td>
</tr>
<tr>
<td>3</td>
<td>Display all scans selected for alignment</td>
<td>Align panel</td>
</tr>
<tr>
<td>Shift</td>
<td>Manually align scans</td>
<td>Align panel</td>
</tr>
<tr>
<td>Space + Backspace</td>
<td>Switch between point sets/pairs</td>
<td>Align panel – points</td>
</tr>
<tr>
<td>Ctrl+B</td>
<td>Open Edges panel</td>
<td>Anywhere exc. modal dialog</td>
</tr>
<tr>
<td>Ctrl+R</td>
<td>Open Repair panel</td>
<td>Anywhere exc. modal dialog</td>
</tr>
<tr>
<td>Ctrl+M</td>
<td>Open Measures panel</td>
<td>Anywhere exc. modal dialog</td>
</tr>
<tr>
<td>Ctrl+U</td>
<td>Open Texture panel</td>
<td>Anywhere exc. modal dialog</td>
</tr>
<tr>
<td>Ctrl+E</td>
<td>Open Editor panel</td>
<td>Anywhere exc. modal dialog</td>
</tr>
<tr>
<td>P</td>
<td>Start Positioning tool</td>
<td>Editor panel</td>
</tr>
<tr>
<td>T</td>
<td>Start Transformation tool</td>
<td>Editor panel</td>
</tr>
<tr>
<td>T</td>
<td>Enable Translate transformation</td>
<td>Editor – Transformation</td>
</tr>
<tr>
<td>R</td>
<td>Enable Rotate transformation</td>
<td>Editor – Transformation</td>
</tr>
<tr>
<td>S</td>
<td>Enable Scale transformation</td>
<td>Editor – Transformation</td>
</tr>
<tr>
<td>X</td>
<td>Translate (rotate/scale) the model along (around/in direction of) X axis</td>
<td>Editor – Transformation – any mode – 3D View</td>
</tr>
<tr>
<td>Y</td>
<td>Translate (rotate/scale) the model along (around/in direction of) Y axis</td>
<td>Editor – Transformation – any mode – 3D View</td>
</tr>
<tr>
<td>Z</td>
<td>Translate (rotate/scale) the model along (around/in direction of) Z axis</td>
<td>Editor – Transformation – any mode – 3D View</td>
</tr>
<tr>
<td>S</td>
<td>Start Smooth Brush</td>
<td>Editor panel</td>
</tr>
<tr>
<td>E</td>
<td>Start Eraser tool</td>
<td>Editor panel</td>
</tr>
<tr>
<td>Ctrl+Shift+Scroll Wheel</td>
<td>Move cutoff plane</td>
<td>Editor panel – cutoff plane selection</td>
</tr>
<tr>
<td>Ctrl+[ or Ctrl+] + Scroll Wheel</td>
<td>Change size of the tool</td>
<td>Editor panel – any tool</td>
</tr>
<tr>
<td>Ctrl+Alt+LMB</td>
<td>Invert selection of 3D regions</td>
<td>Editor panel – any tool – 3D View</td>
</tr>
<tr>
<td>Ctrl+Alt+LMB</td>
<td>Select one scan and deselect the rest</td>
<td>Workspace panel</td>
</tr>
<tr>
<td>Ctrl+LMB</td>
<td>Select one scan and deselect the rest</td>
<td>Workspace panel, first column</td>
</tr>
<tr>
<td>Shift+Alt+LMB</td>
<td>Select/deselect scan</td>
<td>Workspace panel</td>
</tr>
<tr>
<td>Ctrl+A</td>
<td>Select all scans/fusions or frames</td>
<td>Workspace panel</td>
</tr>
<tr>
<td>Ctrl+D</td>
<td>Deselect all scans/fusions</td>
<td>Workspace panel</td>
</tr>
<tr>
<td>Ctrl+Alt+A</td>
<td>Invert selection of scans/fusions</td>
<td>Workspace panel</td>
</tr>
<tr>
<td>F2</td>
<td>Rename scan/fusion</td>
<td>Workspace panel</td>
</tr>
<tr>
<td>Ctrl+P</td>
<td>Start/stop playing frames of scan</td>
<td>Workspace panel</td>
</tr>
<tr>
<td>Del</td>
<td>Delete selected frames/scans</td>
<td>Workspace panel (including Surface list)</td>
</tr>
</tbody>
</table>
Appendix C

EVA Scanners: Hardware synchronization

EVA is equipped with two jacks, designed for 6P6C connectors (RJ12). Creating a bundle, you can connect EVA scanners to each other. Master device is a leading device which sends signals to the next slave device. Each next device is connected to the previous sequentially as shown in figure C.1. Standard phone cable RJ12 6P6C or any other cable with conductors scheme as shown in figure C.1 can be used for connection. Every scanner should also be connected to PC via USB.

**Warning!** Only EVA scanners can be connected to each other. Do not connect EVA to telephone wall port!

![Diagram of synchronization](image)

Figure C.1: Scheme of synchronization. Jacks on the EVA’s body on the left and conductors in the plug 6P6C on the right
Appendix D

Summary of Alignment modes

The table below provides basic information on the alignment modes (Section 5.2).

- **Scan type** column says what kind of scans can be used in each of modes.
- **Scans per operation** is a number of scans which is required for running the mode.
- For some modes point (marker) sets are required, for some are not: **Markers in set** column prescribes, how many markers (points) can be mapped in one point set.
  - “—” means that markers are not needed at all.
  - “0 or 2” means that specifying points is optional, and if specifying, only marker pairs are allowed.
  - “≥ 1” means that unlimited number of markers can be specified in one set.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Scan types</th>
<th>Scans per operation</th>
<th>Markers in set</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rigid (markers)</td>
<td>any</td>
<td>2</td>
<td>2</td>
<td>does not consider geometry, only coordinates</td>
</tr>
<tr>
<td>Rigid (meshes)</td>
<td>any</td>
<td>2</td>
<td>0 or 2</td>
<td>considers geometrical features</td>
</tr>
<tr>
<td>Rigid (texture)</td>
<td>multi-frame with poor geometry</td>
<td>2</td>
<td>0 or 2</td>
<td>be aware of high resource consumption</td>
</tr>
<tr>
<td>Rigid (auto)</td>
<td>multi-frame</td>
<td>any number</td>
<td>—</td>
<td>works if well-textured</td>
</tr>
<tr>
<td>“Drag”</td>
<td>any</td>
<td>2</td>
<td>—</td>
<td>interactive</td>
</tr>
<tr>
<td>Non-rigid</td>
<td>models</td>
<td>any number</td>
<td>0 or 2</td>
<td>deforms surfaces and texture, pre-alignment is required</td>
</tr>
<tr>
<td>Constrained</td>
<td>any</td>
<td>1 (≥ 2 for models)</td>
<td>≥ 1</td>
<td>precise and flexible</td>
</tr>
</tbody>
</table>

Table D.1: Parameters for alignment modes
Appendix E

Assembling the scanner stand

Scanner stand is delivered unassembled with Spider scanner and consists of five parts (see figure E.1: two side walls, front and back walls (two the same parts, in fact) and cover. Before assembling, lay out these parts in the way shown in the figure E.1.

1. Raise two side walls to the upright position, as shown in the figure E.2a. Considering T-shaped slot orientation, install the front wall onto two pairs of hooks of side walls. Press the front wall and slide it down against the stop. Make sure three walls are located on the same level.

2. Install the back wall in the same way (see figure E.2b).

3. Then, paying attention to orientation of the slots, install the cover on the upper hooks of the side walls (see figure E.3a).

4. Press thumbs against T-shaped holes on the cover and shift it in the direction towards the back wall until clicking sound (see figure E.3b).
The scanner stand is now ready for use.

**Note:** To disassemble the stand, release detents in the T-shaped slots in the cover (see figure E.1), using a thin object like a ball pen. Then repeat assembly steps in the reverse order (from figure E.3b to figure E.2a), moving the parts in the opposite direction.
Appendix F

Assembling the calibration rig

Calibration rig is only provided with Spider scanner and consists of the base and the board. To assemble them, follow the instructions below:

1. Press the hinge of the base against your forefingers.
2. Unfold bent leaves of the base, pressing on their edges with the back of your thumbs.
3. Insert the board into the slot formed, as shown in the figure F.1.

Figure F.1: Assembling the rig ver. 1
Appendix G

Third-party 3D sensors

(a) Microsoft Kinect v1
(b) Microsoft Kinect v2
(c) ASUS Xtion (Primesense Carmine)
(d) Intel RealSense 3D camera by Creative (F200)
(e) Laptop featuring Intel RealSense 3D camera

Figure G.1: Third-party 3D sensors
Figure G.2: Operation ranges and fields of view of third-party 3D sensors
Index of parameters

Accuracy, 91
By_radius, 85
error, 91
Fill_holes, 85
Filter_by_threshold, 88
force_constraints, 92
Geometry, 43
iterations, 82
keep_boundary, 92
Leave_biggest_objects, 88
local_align_thr, 34, 82
loop_closure, 43
Manually, 86
max_hole_len, 90
max_hole_radius, 85
max_neighb_normals_angle, 92
minimal_distance, 82
mode, 88
radius, 85
refine_serial, 43
registration_algorithm
  for Fine Registration, 43
  for Global Registration, 82
Remesh, 91
remesh_edge_thr, 91
remove_targets, 86
resolution
  for Fusion, 85
  for Outlier Removal, 84
std_dev_mul_threshold, 83
steps, 90
stop_condition, 91
Texture_and_Geometry, 43
threshold, 88
tri_num
  for Fast mesh simplification, 92
  for Mesh simplification, 91
Triangle quantity, 91
UV_Triangle_quantity, 91
UV_Vertex_quantity, 91
vrt_num, 91
Watertight, 85